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Return-To-Factory Warranty
Psion Teklogix warrants a return-to-factory warranty for a period of one year. In
some regions, the warranty exceeds this period. Please contact your local Psion Tek-
logix office for details. For a list of offices, see Appendix A: “Support Services And
Worldwide Offices”. The warranty on Psion Teklogix manufactured equipment does
not extend to any product that has been tampered with, altered, or repaired by any
person other than an employee of an authorized Psion Teklogix service organization.
See Psion Teklogix terms and conditions of sale for full details.

Service
When requesting service, please provide information concerning the nature of the
failure and the manner in which the equipment was used when the failure occurred.
Type, model, and serial number should also be provided. Before returning any
products to Psion Teklogix, please call the Customer Services Group for a Return
Authorization number. 

Support Services
Psion Teklogix provides a complete range of product support services to its
customers. In North America, these services can be accessed through the Psion
Teklogix Helpdesk. The Helpdesk coordinates repairs and training, helps you to
troubleshoot problems over the phone and arranges for technicians or engineers to
come to your site. For contact information and a listing of worldwide offices, please
refer to Appendix A: “Support Services And Worldwide Offices”. 

Disclaimer
Every effort has been made to make this material complete, accurate, and up-to-
date. Psion Teklogix Inc. reserves the right to make changes without notice and shall
not be responsible for any damages, including but not limited to consequential
damages, caused by reliance on the material presented, including but not limited to
typographical errors.
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APPROVALS AND SAFETY SUMMARY

CE DECLARATION OF CONFORMITY

Product: netpad 1000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common;

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment

Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France



Approvals And Safety Summary

x Psion Teklogix netpad EPOC User Manual

CE DECLARATION OF CONFORMITY

Product: netpad 3000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common; 

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11
EN 60825-1, AM.2: 2001; Laser Safety

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment

Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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FCC INFORMATION FOR THE USA

FCC DECLARATION OF CONFORMITY (DOC)

Applicant’s Name & Address: PSION TEKLOGIX
2100 Meadowvale Blvd.
Mississauga, Ontario, Canada L5N 7J9
Telephone No.: (905) 813-9900

US Representative’s Name & Address: Psion Teklogix Corp.
1810 Airport Exchange Blvd., Suite 500
Erlanger, Kentucky, 41018, USA
Telephone No.: (859) 371-6006

Equipment Type/ Environment Use: Computing Devices for Home and Office Use

Trade Name / Model No.: netpad

Year of Manufacture: 2002

Standard(s) to which Conformity is Declared:

The netpad and Serial Docking Station, supplied by Psion Teklogix, has been tested and 
found to comply with FCC PART 15, SUBPART B - UNINTENTIONAL RADIA-
TORS, CLASS B COMPUTING DEVICES FOR HOME & OFFICE USE.

Applicant: Psion Teklogix Inc.
Mississauga, Ontario, Canada

Legal Representative in US: Psion Teklogix Corp.
Erlanger, Kentucky, USA
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CE MARKING
When used in a residential, commercial or light industrial environment the prod-
uct and its approved UK and European peripherals fulfill all requirements for 
CE marking.

R&TTE DIRECTIVE 1999/5/EC
This equipment complies with the essential requirements of EU Directive 
1999/5/EC (Declaration available: www.psionteklogix.com).

Cet équipement est conforme aux principales caractéristiques définies dans la 
Directive européenne RTTE 1999/5/CE. (Déclaration disponible sur le site: 
www.psionteklogix.com).

Die Geräte erfüllen die grundlegenden Anforderungen der RTTE-Richtlinie 
(1999/5/EG). (Den Wortlaut der Richtlinie finden Sie unter: 
www.psionteklogix.com).

Questa apparecchiatura è conforme ai requisiti essenziali della Direttiva Europea 
R&TTE 1999/5/CE. (Dichiarazione disponibile sul sito: www.psionteklogix.com).

Este equipo cumple los requisitos principales de la Directiva 1995/5/CE de la UE, 
“Equipos de Terminales de Radio y Telecomunicaciones”. (Declaración disponible 
en: www.psionteklogix.com).

Este equipamento cumpre os requisitos essenciais da Directiva 1999/5/CE do Parla-
mento Europeu e do Conselho (Directiva RTT). (Declaração disponível no 
endereço: www.psionteklogix.com).

Ο εξοπλισµός αυτός πληροί τις βασικές απαιτήσεις της κοινοτικής οδηγίας 
EU R&TTE 1999/5/EΚ. (Η δήλωση συµµόρφωσης διατίθεται στη 
διεύθυνση: www.psionteklogix.com)

Deze apparatuur voldoet aan de noodzakelijke vereisten van EU-richtlijn betref-
fende radioapparatuur en telecommunicatie-eindapparatuur 199/5/EG. (verklaring 
beschikbaar: www.psionteklogix.com).

Dette udstyr opfylder de Væsentlige krav i EU's direktiv 1999/5/EC om Radio- og 
teleterminaludstyr. Erklæring findes på: www.psionteklogix.com).

Dette utstyret er i overensstemmelse med hovedkravene i R&TTE-direktivet 
(1999/5/EC) fra EU. (Erklæring finnes på: www.psionteklogix.com).
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Utrustningen uppfyller kraven för EU-direktivet 1999/5/EC om ansluten teleutrust-
ning och ömsesidigt erkännande av utrustningens överensstämmelse (R&TTE). 
(Förklaringen finns att läsa på: www.psionteklogix.com).

Tämä laite vastaa EU:n radio- ja telepäätelaitedirektiivin (EU R&TTE Directive 
1999/5/EC) vaatimuksia. (Julkilausuma nähtävillä osoitteessa:
www.psionteklogix.com).

Use of the 802.11 netpad in France:
Owing to French Government restrictions, the French 802.11 netpad is limited 
to indoor use. They may be used outdoors, on private property, only with prior 
authorization from the French Ministry of Defense.

FCC INFORMATION TO THE USER

RADIO AND TELEVISION INTERFERENCE 
This equipment radiates radio frequency energy and if not used properly – that is, 
in strict accordance with the instructions in this manual – may cause interference to
radio communications and television reception. It has been tested and found to com-
ply with the limits for a Class B digital device pursuant to part 15 of the FCC Rules.
Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and 
2. This device must accept any interference received, including interfer-

ence that may cause undesired operation.

These limits are designed to provide reasonable protection against harmful interfer-
ence in a residential installation. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one
or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation distance between the equipment and the receiver.
• If you are using the equipment with a mains adaptor, plug it into an outlet 

which is on a different circuit from that to which the receiver is connected.
• Consult an experienced radio/TV technician for help.
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For customers in the USA, the following booklet prepared by the Federal Commu-
nications Commission may be of help: “How to Identify and Resolve Radio-TV
Interference Problems”. This booklet is available from the US Government Printing
Office, Washington, DC 20402 - Stock No 004-000-00345-4.

RADIO FREQUENCY EMISSIONS

Do not use in aircraft or hospitals. Some equipment in hospitals and aircraft are not
shielded from radio frequency energy. Do not use the netpad onboard aircraft, or in
hospitals, without first obtaining permission.

Do not use near pacemakers. The product may affect the operation of some medi-
cally implanted devices such as pacemakers, causing them to malfunction. Avoid
placing your product next to such devices. Keep a minimum distance of 15 cm
between the device and the product to reduce the risk of interference. If you have
any reason to suspect that interference is taking place, turn off the netpad and con-
tact your cardiologist for assistance.

Note: In August 1996 the Federal Communications Commission (FCC) of the 
US adopted an updated safety standard for human exposure to radio fre-
quency energy emitted by FCC regulated transmitters. The design of this 
product complies with the FCC guidelines and those standards.

To maintain compliance with the FCC RF exposure guidelines, if you 
wear the netpad on your body, use the supplied or approved carrying 
case, holster, or other body-worn accessory (see page 19 for details). If 
you do not use a body-worn accessory, ensure the antenna is at least 1.5 
cm from your body when transmitting. Use of non-approved accessories 
may violate FCC RF exposure guidelines.

IMPORTANT SAFETY INSTRUCTIONS
This equipment was tested for FCC compliance under conditions that included the
use of shielded cables and connectors between it and the peripherals. It is important
that you use shielded cable and connectors to reduce the possibility of causing radio
and television interference. Shielded cables, suitable for the netpad, can be obtained
from an authorised Psion Teklogix dealer.
If the user modifies the equipment or its peripherals in any way, and these modifica-
tions are not approved by Psion Teklogix, the FCC may withdraw the user’s right to
operate the equipment.
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EMISSIONS INFORMATION FOR CANADA 
This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.

INFRARED DEVICE SAFETY
CLASS 1 LED PRODUCT

This product includes an Infrared device for transmitting and receiving files from
devices supporting the IrDA format. Although this invisible beam is not considered
harmful, and complies with EN60825-1 (IEC825-1), we recommend the following
precautions when the Infrared device is transmitting:

• Do not stare into the Infrared beam.

• Do not view directly with optical instruments.

No parts in the device may be serviced by the user.

INTEGRATED SCANNER SAFETY
For your own safety, it is critical that you comply with the warnings described in
“The Scanner” on page 30.

BATTERY SAFETY PRECAUTIONS
CAUTION!
Danger of explosion if a netpad battery is incorrectly handled, charged, disposed of
or replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the instructions described in
“Lithium-Ion Battery Safety Precautions” on page xvi. Carefully review all battery
safety issues listed in that section.

VORSICHT!
Explosiongefahr bei unsachgemäßem Austausch der Batterie Ersatz nur durch
denselben oder einen vom Hersteller empfohlenen gleichwertigen Typ. Entsorgung
gebrauchter Batterien nach Angaben des Herstellers.



LITHIUM-ION BATTERY SAFETY PRECAUTIONS
Do not store batteries at temperatures in excess of +60°C; the optimum storage tem-
perature for maximum battery life is +10°C to +35°C.

Important: It is critical that this safety information be reviewed and that all 
warnings be strictly followed.

BATTERIES ARE CONSIDERED HAZARDOUS WASTE. Used batteries must
be disposed of in accordance with the manufacturer’s instructions, taken to an
appropriate local battery recycling facility, or returned to one of the following Psion
Teklogix offices for proper disposal. 

Teklogix Inc. Teklogix Corp. Teklogix S.A.
2100 Meadowvale Blvd. 1810 Airport Exchange Blvd. Parc Club Du Golf-Bat 1.
Mississauga, Ontario Suite 500 13856 Aix-En-Provence
Canada Erlanger, Kentucky Cedex 3
L5N 7J9 USA 41018 France

Warning: TO PREVENT the battery from leaking acid, generating heat or 
exploding, adhere to the precautions listed below.

• Use only with the authorized Psion Teklogix power adaptor.

• Do not dispose of in fire.

• Do not incinerate or subject battery cells to temperatures in 
excess of 100°C (212°F). Such treatment can vaporize the liquid 
electrolyte causing cell rupture. Incineration may result in 
harmful emissions or explosion.

• Do not charge, use or store batteries below -30º C (-22° F). 
Batteries must be handled in accordance with all applicable state 
and federal laws and regulations.

• The battery incorporates built-in safety devices. To ensure their 
proper function, do not disassemble or alter any parts of the battery.

• Do not short-circuit the battery by directly connecting any of the 
exposed terminals with metal objects such as wire. Do not trans-
port or store the battery together with metal objects such as 
necklaces, hair pins, etc.
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• Do not use or leave the battery near a heat source such as a fire 
or heater.

• Do not immerse the battery in water.

• When charging, use the battery charger specifically designed for 
the battery.

• Do not crush, puncture, open, dismantle, or otherwise mechani-
cally interfere with batteries.

• Do not directly solder the battery.

• Do not connect the battery to an electrical outlet, vehicle ciga-
rette lighter, etc.

• Do not put battery into a microwave oven or pressurized container.

• Do not use the battery in combination with primary batteries 
(such as dry-cell batteries) or batteries of different capacities 
or brands.

• Immediately remove the battery from the device or battery 
charger and stop use if the battery gives off an odour, generates 
heat, becomes discoloured or deformed, or in any way appears 
abnormal during use.

• Do not continue charging the battery if it does not recharge 
within the specified charge time.

• The battery may burst or ignite if the battery leaks. Always 
ensure that it is away from any exposed flames.

• If a battery should leak, do not allow the contents to come into 
contact with your skin or your eyes. If it does, wash immediately 
with plenty of cold water and seek medical advice.

• Do not store the battery in extremely high temperatures (e.g., a 
vehicle, strong direct sunlight, etc.). This may cause the battery 
to overheat or ignite, and it may also reduce the performance 
and service life of the battery.

• Do not use in areas where static electricity is greater than what 
the manufacturer guarantees.

• Keep batteries out of reach of children.
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1.1  About This Manual
This manual provides information on the operation and features of the Psion 
Teklogix netpad. For additional information, refer to the netpad online help, docu-
mentation supplied with the application you are using, and PsiWin online help, 
available on your PC when PsiWin is installed. The manual references other user 
documents where applicable.

Chapter 1: Introduction
includes an overview of the manual, netpad applications, and instructions for 
accessing the Help files.

Chapter 2: Getting Started
describes the netpad features, using the software, and directions on how to get 
the netpad ready for use, including installation of battery, antenna and SIM card. 

Chapter 3: netpad Docking Station
details the use of the docking station. 

Chapter 4: Using Infrared
describes data transfer and printing using netpad’s Infrared feature.

Chapter 5: Configuring The netpad
provides instructions on configuring the netpad’s security and Control Panel 
features, and includes ways to customize the netpad. 

Chapter 6: Files, Folders, and Programs
describes the netpad’s file manager and how to move around and manage the 
information on the netpad.

Chapter 7: Connecting netpad To A PC
explains how to use PsiWin to copy files between a PC and netpad, and how to 
synchronize files such as Agenda, Data and Contact files. 

Chapter 8: Configuring Communications
provides instructions on the use of GSM/GPRS and 802.11 radios.

Chapter 9: Printing With netpad
details the print capabilities of the netpad, which include printing via Infrared, 
PC, and serial printers.

Chapter 10: netpad Accessories
describes the accessories that are available for the netpad, including the 
Charging solutions and In-vehicle Docking station.
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Chapter 11: Troubleshooting netpad/PsiWin
assists in the recognition and correction of problems that may be encountered 
when operating the netpad and PsiWin.

Appendix A: Support Services And Worldwide Offices
presents information for technical support, contacts and the Psion Teklogix 
worldwide web address.

1.2  Text Conventions
Note: Notes highlight additional helpful information.

Important: These statements provide particularly important instructions or 
additional information that is critical to the operation of the 
computer and other equipment.

Warning: These statements provide important information that may prevent 
injury, damage to the equipment, or loss of data.

1.3  Applications Installed On The netpad
The netpad is capable of running a wide variety of applications but the ones 
available on your particular netpad depend on the purpose for which the netpad is 
provided. A number of standard applications exist and custom programs can be 
installed easily.

The following standard programs are available:

• Word, a word processor for writing letters and other documents.

• Sheet, for spreadsheets, tables, and graphs.

• Contacts, an address book.

• Agenda, a diary program for appointments and lists of things to do.

• Email, for sending and receiving e-mail, SMS and fax messages.

• Opera, for browsing the World Wide Web.

• Calc, a calculator with general and scientific features.

• Jotter, a notebook for jotting down ideas quickly.
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• Time, for alarms and a world map with international times and 
dialling codes.

• Data, a customisable database program.

• Sketch, for drawing pictures.

• Record, for recording and editing voice memos and sounds.

• Program, the editor in which you can create programs using the built-in 
programming language.

• Spell, for checking spelling, thesaurus, solving anagrams and
crossword clues.

• Comms, for terminal emulation and file transfer.

1.4  Caring For The netpad
Screen
When used with the approved stylus, the netpad screen is very resistant to wear and 
impact and should last for a considerable time. Use of any object, other than the 
approved stylus, may result in damage to the netpad screen. 

To maintain the life of the netpad screen, keep the screen clean. To clean the screen: 
switch off the netpad and use a soft, clean, dry cloth to gently wipe the screen. (If the 
netpad is set to turn on automatically when the screen is tapped, you should turn this 
preference off before cleaning the screen.)

Warning: Under no circumstances use chemical solvents to clean the screen.

Charging
To avoid damage to the netpad or the netpad battery packs, use only Psion Teklogix 
approved chargers and docking stations.

Backup Battery
The netpad has a rechargeable backup battery designed to retain data while the main 
battery pack is charging or changed over.
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The backup battery is trickle charged from the main battery pack and has a limited 
lifespan. To maximize the life of the backup battery, avoid excessive discharging and 
recharging of the backup battery by keeping the netpad battery pack fully charged.

Important: If both the main battery pack and the backup battery are allowed to 
fully discharge, all user data held in RAM will be lost.

The backup battery is not user replaceable. If the backup battery requires replace-
ment the netpad must be returned to a Psion Teklogix approved service centre.

Drop Rating
The netpad is designed to survive being dropped on any face, onto concrete, from a 
height of 1.5 m (5 ft.).

Dropping the netpad from greater heights or onto harder surfaces may result in 
damage to the netpad.

IP Rating
The netpad is rated to IP67 and can survive submersion in water to a depth of 1 m 
(3.3 ft.) for up to 30 minutes. Submersion below this depth or for longer periods 
may result in damage to the netpad. 

Operating Temperature
The netpad is designed to operate within the temperature limits of -20°C to +60°C 
(-4°F to 140°F); and -20°C to +55°C (-4°F to 131°F) for scanner variants. Use of the 
netpad outside of these temperature limits may reduce its life. 

Avoid exposing the netpad to sudden changes in temperature, since such exposure 
may result in damage.

Important: As a safety precaution, charging the netpad battery should be 
limited to the temperature range: -20°C to +60°C (-4°F to 140°F); 
and -20°C to +55°C (-4°F to 131°F) for scanner variants. Outside 
of these limits, the safety circuits of the netpad battery pack will not 
allow the battery to charge.
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Storage Temperature
The netpad is designed to be stored within the temperature ranges of -25°C to +70°C 
(-13°F to 158°F); and -25°C to +60°C (-13°F to 140°F) for scanner variants. Storage 
of the netpad outside of these temperature limits may reduce its life. 

To prolong the life of the netpad battery packs during normal storage, store the 
netpad (and the battery pack) between +10°C and +35°C (+50°F and +95°F).

When storing the netpad for a long period of time, the main battery should be 
removed and stored fully discharged.

Humidity
The netpad is designed to operate in humidity ranging from 0 to 95%. Use of the 
netpad in environments with condensing humidity or humidity outside these limits 
may result in damage to the netpad.

Magnetic Fields And Static Electricity
The magnet of the netpad speaker may corrupt data stored on magnetic media. Do 
not keep the netpad next to credit cards or other magnetic media. 

Avoid exposing the netpad to strong magnetic fields or static electricity. Such expo-
sure may cause loss of data or result in damage to the netpad.

Service
Do not attempt to dismantle the netpad. There are no user-serviceable parts inside, 
and any attempt to dismantle the netpad will invalidate the warranty.
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1.5  Additional Programs And Third Party Applications
Psion Teklogix has partnered with a number of companies to provide a suite of con-
nectivity and database tools for the netpad. Below is a list of the partners and their 
applications. More details are available on the Psion Teklogix Partner Program web 
site at: http://partners.psionteklogix.com/partners/.

Afaria
Afaria (from XcelleNet) helps you exploit your existing IT resources by providing a 
cost-effective and reliable way to manage your mobile devices. 

Easy to install and integrate into your current infrastructure, Afaria lets you quickly 
implement systems management for mobile devices to reap the benefits of greater 
efficiency, increased productivity, and improved user satisfaction. In addition, your 
users enjoy improved service levels, hands-free maintenance and shorter connection 
times required to access important corporate information from their mobile devices. 

AirZip
AirZip Accelerator provides plug-and-play performance enhancement for deliver-
ing images—diagrams, CAD drawings, photos, scanned documents—quickly and 
easily to mobile devices.

• AirZip Accelerator transparently boosts download speeds by 300-500%, 
and reduces device memory storage requirements by up to 80%.

• AirZip Accelerator makes it possible to include mission-critical images and 
graphics as part of Psion Teklogix solutions, dramatically improving end 
user productivity, and overall solution ROI.

• AirZip Accelerator works with any web application or content, and all 
Psion Teklogix EPOC or WinCE devices.
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Broadbeam
Broadbeam Corporation is a proven wireless platform provider that offers the 
industry-leading Axio™ platform, SystemsGO!™ wireless managed services, and 
Professional Services that allow customers to rapidly create, deploy and manage 
wireless applications.

Headquartered in Princeton, NJ, Broadbeam has multiple offices throughout the 
United States, Japan and the United Kingdom, and serves over 500 customers on six 
continents.

CIC
InkTools™ is a high performance software developers kit for implementing 
systems using electronic ink or handwritten signatures. The toolkit enables applica-
tion developers to create eSign compliant software. InkTools™ provides electronic 
ink capture and display, signature verification, encryption and ink compression as 
well as other algorithms that can add competitive and performance value to a wide 
variety of vertical applications as well as document and transaction based applica-
tions. Developers use InkTools™ to add electronic handwritten signature and secu-
rity features to enterprise applications deployed on mobile platforms.

Citrix
Psion Teklogix and Citrix are pleased to be able to announce the availability of the 
Citrix ICA client running on Psion Teklogix devices supporting the EPOC platform. 
This gives Psion Teklogix and Citrix solution providers the opportunity to provide 
solutions that can deploy a wide range of traditional back office solutions onto most 
of the devices in the Psion Teklogix range.

Eliad
Eliad Technologies, Inc. provides Java™ small footprint display technology for 
advanced interfaces on multiple platforms. Eliad works with market leaders to 
define tomorrow’s architecture for mobile computing. Eliad offers include two fam-
ilies of products: 

• XML-Run™ : XML/Java GUI technology for mobile applications.

• JSmartGrid™: Advanced Lightweight and powerful Java™ Swing 
component.
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Ericom
PowerTerm WebConnect is a comprehensive platform-independent, Java-based 
web-to-host connectivity solution for Psion Teklogix mobile computers, desktop 
PCs and many thin client and PDA devices. PowerTerm WebConnect provides a 
robust connection to a wide variety of hosts including IBM Mainframe, IBM 
AS/400, Unix, Tandem, VAX/VMS, Alpha/OpenVMS, Hewlett Packard, SCO, 
Data General and others.

Extended Systems
XTNDConnect Server is server-based synchronization and device management 
software from Extended Systems that allows information to be transferred directly 
between corporate applications and mobile devices without understanding IT con-
cerns associated with corporate standards, security, data encryption or support costs.

FieldWorker
FieldWorker is a Rapid Mobile Application Development Utility written in Java 
that has allowed FieldWorker, our resellers and our customers, to create over a 
hundred mobile applications for a wide variety of different vertical applications. 
FieldWorker is designed to be handheld PC independent, operating system indepen-
dent, communications infrastructure independent and even language independent. 
FieldWorker is designed to capture and exchange data with almost any ODBC SQL 
compliant databases using docking cradles, wired and wireless LANs and WANs, 
and even browsers on the Internet.

IBM DB2 Everyplace 
IBM’s DB2 Everyplace is a small footprint relational database and synchronization 
server designed to extend enterprise computing to mobile devices. DB2 Everyplace 
is being used by application developers, systems integrators and enterprises around 
the world to enable enterprise applications to be used on mobile devices. The DB2 
Everyplace solution has the following key components:

• The DB2 Everyplace database on the mobile device is a small footprint, 
robust, relational database.

• The SQL statements supported by DB2 Everyplace allow you to create or 
drop a table or index, and delete, insert, or update rows of a table. The DB2 
Everyplace database supports the following mobile platforms: EPOC, 
Palm, WinCE/Pocket PC, embedded Linux and the desktop platforms of 
Win32 and Linux.
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IBM MQSeries Everyplace
IBM MQSeries Everyplace extends the IT infrastructure to include dependable 
and secure communications with mobile workers into what was a failure-prone 
environment, allowing them to access corporate data and applications on any of the 
35 platforms in an MQSeries network. It connects laptops, PDAs and phones, and 
unattended devices such as servers, sensors and probes. It includes rich extensible 
security options and can easily work through firewalls. MQSeries Everyplace 
allows mobile workers do their work anyplace, anytime, anywhere—safe in the 
knowledge that their messages will get through.

Impatica
Impatica technology enables Microsoft PowerPoint™ presentations to be viewed 
on the EPOC OS by quickly converting the presentation into a Java applet that can 
be viewed with the mobile computer’s web browser. The ‘impaticised’ presentation 
can either be stored and accessed locally on the device, or run over the Internet. 
Impatica enables interactive rich media content on the netpad. 

Informix
A high performance, function-rich SQL database for Java applications along with 
synchronization technology that allows data to be shared with enterprise database 
servers (Informix, DB2, Oracle etc.). Informix Cloudscape is a platform that com-
prises three major elements: 

• Cloudscape - A small footprint, 100% Pure Java™, object-relational data-
base management system.

• Cloudsync - An innovative way to maintain agreement between central 
applications and distributed applications that may only be occasionally con-
nected to the Internet.

• Cloudconnector - A server framework that supports connection pooling, 
remote JDBC, HTTP, and HTTPS connections from an application to a 
Cloudscape database.
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KI
MobileIntegrator from Ki is a rapid application development tool that has been 
used to write applications as simple as a questionnaire of a few lines, and as 
complex as complete support for medical rounds or anamnesis with tens of thou-
sands of data entry fields structured in hierarchical trees. By using the XML-format 
for the internal representation of the input dialogues as well as the captured data, the 
resulting applications are flexible enough to be very easily integrated into existing 
system environments.

Oracle
Psion Teklogix and Oracle Corporation are pleased to announce availability of 
Oracle 8i Lite for Psion Teklogix devices. Oracle 8i Lite, the Internet platform for 
mobile computing, is a complete platform for developing, deploying, and managing 
mobile applications. Oracle 8i Lite comprises two elements: Oracle Lite DBMS, 
Consolidator and Web-to-go.

Palmware
MPS is a virtual computer universal interface eliminating the differences between 
platforms (hardware and software) offered by IT and telecommunications vendors. 
MPS works in a complementary way with the machine’s native operating system, 
and it is designed for mobile platforms. MPS guarantees the use of a standard appli-
cation across a wide variety of platforms. What this means to developers is that 
MPS offers a single development environment, irrespective of the varying OS 
requirements that may otherwise be made by a diverse range of target systems while 
being able to retain their individual capabilities and performance characteristics.

Sybase
SQL Anywhere Studio is a suite of products for database development and data 
synchronization. The suite includes a full database development environment 
(Adaptive Server Anywhere) and a small fingerprint database designed for small 
devices. The components of the product suite are:

• UltraLite deployment technology for Adaptive Server Anywhere generates 
an application optimized database targeting memory constrained devices.

• MobiLink synchronization technology provides for the secure, bidirectional 
exchange of enterprise information between remote devices and heteroge-
neous data sources including Sybase, Oracle, Microsoft, and IBM.
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Tao
Tao’s Intent® provides application developers with the ability to run compliant 
Personal Java applications very fast and in addition exploit a rich set of Multimedia 
features to complement those AWT functions associated with the Java Virtual 
Machine. Intent® enables Java applications to run on the netpad extremely fast, 
making the deployment of Java applications for enterprise client devices a reality, as 
well as providing a platform to run compelling content.
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2.1  Features Of The netpad
The EPOC netpad is a 32-bit mobile tablet computer with a 1/2 VGA touchsensitive 
screen. netpad is lightweight, shock and water-resistant, and designed for use in a 
wide range of business areas including field service, field sales, transport, health 
care, hospitality, manufacturing and insurance. It is available in variants with inter-
nal GSM/GPRS, 802.11b radios and scanners. 

Figure 2.1 netpad Front 

Figure 2.2 Back Of netpad
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Figure 2.3 Location Of Scanner

2.2  Preparing The netpad For Use
2.2.1  Fitting The Antenna
Before using netpad units fitted with either the GPRS or 802.11 radio, the antenna 
must be installed. The antenna should be installed as shown in Figure 2.4 below. To 
install the antenna turn it counter clockwise; to remove the antenna turn it clockwise. 

Figure 2.4 Antenna Insertion And Removal

Scanner Window
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2.2.2  Use Of The Soft Belt Holster

Figure 2.5 Insertion Of netpad In Holster

Important: The netpad and holster have been tested to ensure compliance with 
the latest FCC RF exposure guidelines. For continued compliance 
when using the netpad and holster combination, the face shown 
should be fitted against the body! The user must not modify the 
holster in any way.

Figure 2.6 Holster Position On Body
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2.2.3  Power
2.2.3.1 Power Management
The netpad is powered by a Lithium Ion rechargeable battery pack, which under 
optimal operating conditions will provide power for a full shift. The netpad will 
warn you when the main battery charge is low.

Note: How long your batteries last will depend upon how you use your netpad. 
The netpad will use considerably more battery power when you are 
recording sounds, have the brightness turned up, are using files stored on 
a multimedia card, or are using Infrared.

You can take steps to help prolong your battery’s life:

• Turn the screen brightness down.
• Set automatic switch-off in the Power control panel.
• Use files on the internal disk instead of an MMC, as the netpad requires 

more power to write to the multimedia card.
The netpad can be powered from AC when used in the docking station (see page 
43). When the netpad is powered from the docking station, it will also charge the 
battery pack.

2.2.3.2 Fitting The Battery
Before you can use the netpad you must fit the battery—slide it into place until it 
clicks, as shown in Figure 2.7 on page 21.

Important: Take care when replacing batteries! The netpad will warn you when 
its main battery is getting low, in plenty of time to change/charge it. 
The backup battery is designed to maintain the memory for several 
hours. However, prolonged reliance on the backup battery does 
reduce its life. 
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2.2.3.3 Charging The netpad Battery Pack
To charge the battery, attach the battery pack to the netpad and place the complete 
netpad in a netpad docking station (for instructions, please refer to “Using The 
Docking Station” on page 43), or place the battery in one of the optional battery 
chargers. The standard (850 mAH) netpad battery will normally be fully charged 
within 2 to 2.5 hours (3 hours for a 1400 mAH battery pack).

2.2.3.4 How Do I Check The Battery Power?
To check the battery power, tap the Menu icon to the right of the screen (see “The 
Screen, Command Icons And Toolbar” on page 28), and select the Information 
menu, then Battery. To check the battery power, move to the System screen and 
select Battery from the Information menu. The Summary panel gives a brief 
description of the state of the main battery and the backup battery as well as a per-
centage of charge remaining. 

2.2.3.5 Changing Battery Packs
If you are using your netpad away from the charger and a spare battery pack is avail-
able, you can change batteries when the battery warning is displayed. To do this:

1. Switch the netpad off.

2. Press on the battery pack latch to remove it.

3. Push in the replacement battery pack.

Figure 2.7 Battery Insertion

Battery Pack
Direction of
Insertion

Battery
Latch

Battery Contact Pins
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Important: Always switch off the netpad before removing the main battery. 

Never remove the battery from the netpad while it is in the 
docking station. 

Never use a netpad without a battery in the docking station.

2.2.3.6 Prolonging Battery Life
When your netpad is switched off, it is on “standby” and will continue to use a small 
amount of battery power. If you are going to leave your netpad switched off for a 
long period of time, you are advised to back up your data beforehand because the 
batteries will eventually run out.

Note: To check the battery power, move to the System screen and select Battery 
from the Information menu.

2.2.3.7 Internal Backup Battery
The netpad has a rechargeable backup battery designed to retain data while the main 
battery pack is charging or changed over. The backup battery is trickle charged from 
the main battery pack and has a limited lifespan. To maximize the life of the backup 
battery, avoid excessive discharging and recharging of the backup battery by 
keeping the netpad battery pack fully charged. 

Important: If both the main battery pack and the backup battery are allowed to 
fully discharge, all user data held in RAM will be lost.

The backup battery is not user replaceable. If the backup battery requires replace-
ment, the netpad must be returned to a Psion Teklogix approved service centre.

Important: If both the batteries run out of power you will lose all your informa-
tion on the internal disk.

2.2.4  Multimedia Cards
Multimedia cards (MMCs) are non-volatile memory cards, which fit into a dedi-
cated slot in the netpad and can be used to store application software and/or data. 

The MMC slot is located on the right hand side of the netpad. 
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Inserting And Removing An MMC 
• Open the card slot door located on the side of the unit by sliding the retain-

ing latch. Push the MMC into place until it clicks. Close the door.

• To remove an MMC, open the door and push the card. Store your MMC 
safely, particularly if it contains valuable data.

Figure 2.8 MMC Slot Location

2.2.5  Installing And Removing The SIM Card
A netpad fitted with a GSM/GPRS radio requires a Subscriber Identity Module 
(SIM) card installed in order for the netpad to access the GSM network. The SIM 
card fits into a dedicated slot in the netpad. 

The SIM card slot is located behind the Card Slot door on the right-hand side of the 
netpad; and is located below the Multimedia card (MMC) slot (see Figure 2.9 on 
page 24).

Card Slot Door Latch

MMC Card

Reset
Button
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Figure 2.9 Location Of SIM Card And MMC

Important: The MMC slot and SIM slot are located very close together. When 
inserting or removing the SIM card be careful not to drop the SIM 
card into the MMC slot.

Inserting The SIM Card
Warning: To prevent damage to the SIM card, ensure that the netpad is 

switched off and the battery removed before inserting the SIM card.

• Remove the battery pack from the netpad.

• Open the card slot door located on the side of the unit by sliding the 
retaining latch. 

• Push the SIM card into place until it is fully inserted. Note the orientation of 
the card, shown in Figure 2.10 on page 25, with the notch of the card on the 
left, trailing side. 

• Close the door.

SIM Card

MMC

Card Slot Door

(screen side up)
Orientation of netpad
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Figure 2.10 Insertion Of SIM Card

Important: Ensure that the SIM card is inserted in the correct orientation as 
shown. Once inserted, the SIM card can only be removed using a 
pair of tweezers or long-nosed pliers. If the SIM card is inserted 
incorrectly, the unit will not connect to the GSM network. 

If the SIM card is inserted incorrectly, it must be removed by follow-
ing the instructions given on “Removing The SIM Card”, below.

Removing The SIM Card
Warning: To prevent damage to the SIM card, ensure that the netpad is 

switched off and the battery removed before removing the 
SIM card.

• Open the card slot door and grasp the card on the cross-hatch area (see 
Figure 2.11 on page 26), using the special removal tool supplied, a pair of 
tweezers, or long-nosed pliers. Pull the card out carefully.

MMC

SIM Card

SIM Card SlotOrientation of Card
(notched corner)
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Figure 2.11 Removal Of SIM

2.3  Turning On And Off
To switch on: 

press the On/Off button. When you first do this, you’ll see the System screen.

Note: The ability to turn on the unit by tapping the screen is configured and con-
trolled by a setting under the Power Icon on the Control Panel (see page 
58). The netpad can also be switched on under program control, such as 
when an alarm rings.

To switch off: 
press the On/Off button on the top. You can switch off at any time. You do not 
have to save your information first, as it is automatically saved for you. How-
ever, if you are working with a file on the MMC, save the file before switching 
off the netpad and removing the card.

Note: If you do not use the netpad, it will automatically switch off after 5 min-
utes to save battery power. Switch it on again, and you can continue from 
where you left off. (The time for automatic switch off can be modified via 
the Control Panel—see page 58.) The netpad also has other features for 
minimizing its power consumption and maximizing battery life. These fea-
tures can be accessed via the Control Panel on page 58.

MMC

Orientation of netpad

Cross-hatched Area of SIM Card

(screen side down)

(grip here with pliers)
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2.4  Finding And Using The Stylus
The stylus is located in a holder at the right. To remove it, slide the stylus out of the 
top of the netpad. To replace it, push it back in.

Tap lightly on the screen using the stylus. You can use your fingers to tap on the 
screen, though it is best to use the stylus to avoid fingerprints or smudges on the 
screen. Do not tap the screen with any object that has a sharp tip or you may damage 
the screen. Don’t use any type of ink pen, as the ink may be impossible to remove. 
See “Caring For The netpad” on page 5 for instructions on how to clean the screen.

You can usually tap on an item with the stylus to select or change it. For example, 
you can tap on:

• the program icons, to open a program.

• the command icons, for “shortcuts” to System functions, e.g. the menu bar, 
cutting and pasting, Infrared, zooming in and out.

Note: If the screen doesn’t respond to your taps, you may need to re-calibrate it. 
You can do this by opening the Screen icon from the Control Panel.
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2.5  The Screen, Command Icons And Toolbar
The netpad screen has a column of permanent “command icons” on the right-hand 
side.

From top to bottom, these are:

Menu: 
Displays the menus for the current program. Menus are displayed 
along the top of the screen.

Contrast and brightness control: 
Tap the icon repeatedly to cycle through the default brightness levels.

Important: Battery life is considerably reduced when the brightness 
is increased.

Zoom control: 
Tap the icon repeatedly to cycle through the zoom settings. The zoom 
settings depend on the application you are in and are stored indepen-
dently for each application.

Keyboard: 
Displays the Psiboard, the on-screen keyboard.

System command icon: 
When you are in a program, the System command icon displays the 
System screen. From the System screen, tapping the icon displays the Program 
bar containing the icons for the programs installed on your netpad.

When you are in a program, the program’s Toolbar is usually displayed to the left of 
the command icons. This Toolbar contains four icons with the name of the program 
above them. Tapping on the name displays the list of open files and folders. Below 
the name are four icons that vary from program to program and are the most com-
monly used functions for each program.

2.6  How To Reset The netpad 
If you find that you cannot exit a program normally, move to the System screen and 
select the List open files command from the File menu. Select the program from the 
list and press the Close file button. If this does not work, or if your netpad appears to 
have “locked up”, you can always perform a “soft reset”. This should restart your 
netpad while preserving most of your information. 
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It is worth trying a soft reset if the keys on the netpad do not appear to respond, or if 
the netpad appears to switch on and you are sure that the batteries are good (especially 
if the contrast adjustment still appears to work), but the screen is otherwise blank.

To perform a soft reset: 
gently press the stylus onto the reset button. This is located inside the card slot 
door cover to the side of the MMC slot.

Figure 2.12 Reset Button Location
Press the On/Off button to restart the netpad—you will hear two beeps during boot-
up to indicate the reset. After a soft reset, any changes to open files will be lost. Your 
other files on the internal disk will almost always be safe.

It is possible (although unlikely) that performing a soft reset after a program failure 
may cause the netpad to lose the information on the internal disk; it could even 
prevent the reset from working at all. If this happens, you will have to perform a 
“hard reset”.

Important: A hard reset resets the netpad completely, and all information on 
the Internal disk will be lost.

To perform a hard reset: 
1. Remove the netpad from the docking station (if applicable).
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).
4. While continuing to hold down the On/Off button, press and release the 

Reset button. 
5. Release the On/Off button. 
6. Refit the battery into the netpad—the unit will power up and you will hear

one beep during boot-up.

MMC

SIM Card

Reset Button
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2.7  The Scanner
Where fitted with a bar code scanner, the netpad may be used to read industry 
standard bar codes. 

To scan a bar code, point the scanner window at the bar code, ensuring that the 
scanner window is not obstructed and that you are between 5 cm (2 in) and 60 cm 
(24 in) from the bar code. Activate the scanner as instructed in the software applica-
tion’s operating instructions. The scanning beam should be energized until a 
successful decode is achieved or three seconds have elapsed.

Figure 2.13 Scanner Location

Warning: For your own safety, it is critical that you comply with the 
following warnings:

1. Do not look into the scanner window.
2. This product contains a laser scanner that emits less than 1.2 mW 

average radiant power at a wavelength of 650 nm. This product 
complies with 21 CFR 1040.10, 1040.11 and DIN EN 60825-1: 
January 2001, and is classified as a Class 2 laser product.

3. CAUTION – Using controls or adjustments, or performing proce-
dures other than those specified herein may result in hazardous 
radiation exposure.

4. CAUTION – The use of optical instruments with this product will 
increase eye hazard.

Scanner Window
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2.8  First Steps
When you first switch on the netpad, you will see the System screen. This is the 
“desktop” where you can view your files and folders, and change settings that 
control how the netpad works.

• All the information you enter into the netpad is contained in files; their 
names are displayed in the System screen, beside icons that represent the 
programs that created them.

• All your files are stored in folders. When you start using the netpad, the 
contents of the Documents folder is displayed.

• The System screen’s Title bar shows you which folder is currently dis-
played on the screen. When you start, you are in the Documents folder on 
the C (Internal) drive.

You can have as many folders as you wish, and create folders within other folders. 
Folders can contain files created in a variety of programs; they are not restricted to 
files from a single program. See Chapter 6: “Files, Folders, and Programs” for 
details of managing files and folders.

2.8.1  Aligning The Touch Screen
You can ensure that the touch screen is properly calibrated using the Screen menu.

1. In the System screen, tap on Control Panel on the Toolbar, or select the 
command from the Tools menu.

2. Tap the Screen icon.

3. The Screen settings dialogue comes up. Tap the Calibrate button at 
the side of the page, then follow the instructions on the screen. You will 
be asked to tap the centre of each point indicated on the screen. At the 
conclusion of the test, the calibration will be completed when you 
accept the new settings by tapping on the Yes button.
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2.8.2  Navigating Between Files And Folders
• Tap on a folder icon to move to that folder, tap on the Close folder icon to 

close it and move back up a level.

• Tap on a file to select it, tap again to open it. If the file name is displayed in 
bold, the file is open, and tapping it will move straight to the file.

See Chapter 6: “Files, Folders, and Programs” for more information about manipu-
lating files and folders.

2.8.3  Starting Programs
When you open or move to a file, the correct program for this file is started automat-
ically. You can also start programs by tapping on the appropriate program icon.

• If necessary, tap the System icon  at any time to move to the 
System screen.

• Tap on it again to display the Program icon bar, which contains more 
program icons.

You don’t have to close one program before opening another, just tap on another 
program icon, and that program will open too.

You can see what files and programs are open from the System screen by using the 
List open files command from the File menu, or by tapping on the name in the top 
right corner of the screen.

 

Title Bar

Folder

Command

Toolbar

Current Folder
Icon Bar
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2.8.4  Programs And Files
When you run a program, it will usually display the currently open file, or the file 
that you last looked at. If you want to write a new letter, draw a new picture, 
create a new database and so on, you’ll need to create a new file for the particular 
program involved.

To create a new file: 
select the Create new file command on the File menu and type in the name for 
the new file (see “Entering Information”, below). The file will now be created, 
and the current file will be closed and saved at the same time. You can start 
entering your information.

You can also use this command in the System screen to create a new file. Usually, 
this creates a file using the standard settings; creating a file from within a program 
creates a file that already has any settings or preferences you have set up in 
the program.

It is a good idea to keep related files together in a folder, to make the files easier to 
find later. See Chapter 6: “Files, Folders, and Programs” for details of how to 
manage your files and folders.

2.8.5  Entering Information
You can enter information and complete tasks using the stylus or the Psiboard. The 
Psiboard is displayed by tapping the Keyboard command icon.

Sizing Corner
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You can:

• Move the keyboard by tapping the title bar and dragging it.

• Resize the keyboard by dragging the bottom right-hand corner.

• Minimize the keyboard by tapping the underline symbol on the top right-
hand corner of the keyboard.

• Maximize the keyboard again when you need to type something, by tapping 
the underline symbol.

Tap the P symbol to display and set the keyboard preferences; for example if you’re 
using a program such as Word in which you need to type a lot of text, you may want 
to set ‘Always on top’ to prevent the Psiboard from disappearing every time you tap 
on another part of the screen. Then, to move the Psiboard out of the way, 
minimize it.

When you are in a dialogue in which you need to enter information, Psiboard is dis-
played in a different mode. When you tap twice in a line, the keyboard opens. As 
you type the text is shown. When you tap Done, the keyboard closes and the line of 
text is entered in to the dialogue. You can use the Next and Prev buttons to move 
between items on the dialogue.
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Note: Psiboard is the netpad’s default keyboard. If you load a different keyboard 
you can use this instead. In the Control Panel, select the Text input icon, 
and select the new application from the list.

2.8.6  Displaying Help
Help can be displayed at any time from the standard netpad programs including the 
System screen. Help information is contained on a series of “Help cards”. Help is 
specific to the program that you are using; wherever you are, you can just type a 
“clue” to search for the information you need.

Note: The online help contains more detailed information than is included in 
this manual.

To display Help: 
Select the Help command from the Tools menu. In the System screen, general 
help on the netpad is also available.

To search for help about something: 
type your clue into the Find: box, and press Enter. If the Quick find button is 
selected from the Toolbar, the display will show a list of Help cards with the 
clue in the title or initial description. Alternatively, if the Find in all button is 
selected, the display will list all cards with the clue in the text. To move between 
cards, tap on the Prev or Next buttons, press Enter, or use the left and right 
arrow keys.

To look through the help text: 
drag the scroll bar on the side of the Help card, or tap the up and down 
arrow keys.

To print the current Help card: 
tap the Print button on the Toolbar or select Print from the File menu.
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To type in another search word: press Esc, and then type in the word to search for 
as before. To use one of the last five search words again, tap on the button next 
to the Find: box, or press Tab and select the word you want to use.

To return to the program you were using: 
tap the Go back button on the Toolbar, or tap the program’s icon.

Note: You can highlight text in a Help card using the stylus or keyboard, and 
copy it to use in a file of your own. Copy the text by selecting the Copy 
command from the Edit menu. Then go to your own file, and paste it in.

2.8.7  Using Menus
You can usually select a menu command to perform each task.

• Press the Menu key on the Psiboard or tap on the  command icon to see 
the available commands on the Menu bar.

• Tap on the menu names and commands, or use the arrow keys to move 
around the menus. Tap on commands marked with a  or press the right 
arrow key to see further commands.

Note: You can press the shortcut key combinations shown next to the commands 
as a quick way of selecting them, e.g. Ctrl+M, means hold down the Ctrl 
key and press the M key at the same time.

Go Back

Text Found By Search Help Topics In Card Browser

Search Clue Help On Topic Card
Without
Closing Help
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A menu command with three dots at the end means that selecting the command will 
display a “dialogue” where you enter more information (see Section 2.8.8).

If a menu command is grey, it means that it’s not currently available; e.g. you cannot 
Copy unless you have first selected something to copy.

2.8.8  Using Dialogues
A “dialogue” appears when you need to make selections and enter further informa-
tion. You can move between dialogue items by tapping on them, or using the up and 
down arrow keys. Dialogues contain one or more of the following elements:

Textbox: 
where you just type in your information. When you tap in the textbox, Psiboard 
opens so you can type in.

Listbox: 
where you select from a number of options. You will see left and right arrows 
around the current selection; you can change the selection by tapping on the 
arrows, by pressing the left and right arrow keys, or by typing the first letter of 
the option you want. You can usually tap in the box or press the Tab key to see a 
list of the available options.

Checkbox: 
where you make a choice between selecting an option or not selecting it. Just 
tap on the checkbox, or press the left and right arrow keys to add or remove
a checkmark.

Radio buttons: 
where you make one choice from a number of options. Just tap on an option, or 
use the left and right navigation buttons to make a selection.

If a dialogue line is grey, it is currently not available, usually because you have to 
select something else first. For example, if you have not checked the box to set an 
alarm for an Agenda entry, the lines to set the alarm time and date are grey. Some 
dialogue lines only appear when another option has been chosen.
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Some dialogues comprise a number of “pages”, each page has a “tab” at the top. Tap 
on the tab, or move the highlight to the tab name, to go to that page. You can also 
move a dialogue around the screen by holding the stylus on the dialogue title bar and 
dragging it across the screen.

2.8.8.1 Dialogue Buttons
Dialogues may have on-screen buttons. Tap on the button. Some buttons have a 
standard keypress equivalent:

• Usually, you can tap the OK button or press the Enter key if you want to 
save information and remove the dialogue.

• Tap the Cancel button or press the Esc key if you want to remove the dia-
logue without saving the information.

• For dialogues that ask a question, you can tap the Yes button or press the Y 
key for ‘yes’; tap the No button, press the N key, or press the Esc key for ‘no’.

2.8.8.2 How To Display A Calendar
In most dialogues in which you can type a date, move to the date line then tap again 
or press Tab to display a calendar.

Today’s date is circled, and the date currently displayed in the dialogue is high-
lighted. To select another date, move to the date you want and press Enter. Use the 
buttons on the top line, or further presses of the Tab key, to display a three month or 
twelve month calendar. Use the “dog ears” to move between the pages of the calendar.

Dialogue Page

Radio Button

Listbox
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You can also display a calendar from the Agenda program. See the Agenda docu-
ment for more details.

2.8.9  Copying Information Between Programs
You can insert information created in one program into a different program. This is 
known as “inserting” an “object”.

For example, you may want to add a picture to a letter you are writing. To do this, 
write the letter as normal, for example using the Word program. Then, while in 
Word, tap the Insert sketch button on the Toolbar or select the command from the 
Insert menu. This will start the Sketch program (if it is installed), where you can 
create the picture. Close Sketch when you have finished and the picture will be 
inserted into your letter.

Sometimes the object you insert can be displayed as an icon, for example, if you 
insert a large amount of Word text into an Agenda entry. (Agenda is netpad’s stan-
dard calendar program.) Alternatively, you may prefer to see the actual information 
added, e.g. a map to view in the Word file.

For example, you may wish to:

• insert tables of figures and graphs from a spreadsheet such as Sheet into a 
Word file. You can add labels and titles to the graph in Sheet before insert-
ing it in the Word file.

• keep a map of how to find a restaurant as a sketch, perhaps attached to an 
Agenda entry for the day that you’re going there.

• create a Sketch file of your signature, and insert the signature when you 
write letters in the Word processor.

• keep handwritten notes and ideas in Sketch. You can then insert them into 
the Jotter notepad program or a Word file if necessary.
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3.1  Using The Docking Station
This chapter describes the netpad docking station. The docking station is used as a 
convenient “drop-in” holder for the netpad, supplying power and communications 
through the docking station connector.

Figure 3.1 Docking Station Features

To insert the netpad into the docking station, align the two devices, and press down 
on the netpad until the connection is made. To eject, press down on the release 
button at the top of the docking station. The netpad will be pushed up and out of the 
docking station.

While the netpad is in the docking station, the communications port on the netpad 
can still be used. The docking station communications port is available for conve-
nience.

You can rotate the orientation of the docking station on its stand. Hold the top of the 
docking station in one hand and the bottom in the other. Lift the top part to release it 
and rotate through 90°. When you let go of the top part, it will click into place.

netpad Connectors Communication Ports

Power Jack

IR Ports
Release Button

Yellow LED indicates 
communications

Red LED indicates charging/
Green LED indicates charged

Red LED indicates power
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3.2  Communications Settings
When performing PC communications, it is necessary to define the communication 
settings.

In the Link to desktop dialogue (from the Tools menu in System screen), the Link 
options are: Off, Cable, or Infrared. 

• Cable specifies using the RS232 communications port on the left-hand side 
of the machine. 

• Docker specifies using the RS232 communications port on the right-hand 
side of the docking station.

• Infrared specifies using the IR port on the back of the netpad.

For details on configuring the Modems dialogue of the Control Panel, please refer to 
“GSM/GPRS Modem Configuration” on page 129 and “Connecting The Modem 
(Serial)” on page 140.
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4.1  Introduction
The netpad has Infrared built in, allowing you to transfer selected information to 
another netpad or other Psion Teklogix device without the use of a cable.

You can also use Infrared to print directly to printers that support Infrared - see 
“Printing Using Infrared” on page 152 for more details.

4.2  Selecting Data To Transfer 
On the machine from which information is to be transferred (the ‘sending 
machine’), select the information you want to transfer:

• If the information is a file, ensure that the file is closed and highlight the file 
name on the System screen. Drag the pen if you want to transfer more than 
one file.

• If the information is an object already inserted from another program, e.g. a 
graph displayed in Word, just select the object. If the inserted object is dis-
played as an icon, you can just select the icon.

• If the information is an Agenda or Data entry, open the appropriate file and 
move the cursor to the required entry.

• If you wish to transfer a graph, highlight the cell contents in Sheet view. 
Graphs cannot be transferred direct from one Sheet file to another, only the 
cell contents. Relative and absolute cell references are preserved.

• In all other cases, open the file from which the selected information is to be 
transferred, and select the required information (e.g. the piece of text, range 
of spreadsheet cells, sketch area).

Note: Objects can be transferred like other information. They appear as objects 
on the receiving machine.
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4.3  Transferring The Information 
1. Ask the user of the other netpad or Psion Teklogix device to open the 

program or file where the information is to be transferred to.

• If the information to be transferred is an entire file, ask the other user to 
tap the System icon and move to the folder to which the file is to be 
transferred.

• If the information is an Agenda or Data entry, ask the other user to open 
the appropriate Agenda or Data file.

• In all other cases, ask the other user to open the file or program to which 
the selected information is to be transferred, and move the cursor to the 
appropriate point in the file.

2. On the receiving machine, select the Infrared receive command from 
the Tools menu. The Ready to receive screen is displayed.

3. Position the two machines, aligning the Infrared windows (ideally, both 
should be resting on the same flat surface). The Infrared window on the 
netpad is on the top of the machine (see “Features Of The netpad” on 
page 17). The machines should be no more than one metre apart.

4. On the sending machine, select the Infrared send command from the 
Tools menu. If the Infrared windows are in range, the transfer begins. 
Infrared screens appear on both machines to indicate that the transfer is 
taking place, and the progress of the transfer is displayed.
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4.3.1  When The Transfer Is Complete 
When the transfer is complete the Infrared screens disappear. There is now a copy of 
the selected information or file on the receiving machine.

Note: If a file is being transferred, and the folder on the receiving machine 
already contains a file of that name, then the receiving machine displays a 
dialogue where you can rename the received file, or move it to another 
folder or disk drive.

The transfer does not affect the information on the sending machine.

4.3.2  Cancelling The Transfer 
To stop the transfer while it is in progress, press Esc on either machine.

4.3.3  If The Transfer Fails 
If the transfer fails, a message is displayed to indicate why. Follow the advice given 
by the message and try again.





Psion Teklogix netpad EPOC User Manual 51

CONFIGURING THE NETPAD 5
5.1  Things To Do First . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.1.1  Entering Owner Information . . . . . . . . . . . . . . . . . 53
5.1.2  Setting A System Passcode . . . . . . . . . . . . . . . . . 54
5.1.3  Setting The Time, Date And Home City. . . . . . . . . . . 55
5.2.4  Power and Power Saving Mode . . . . . . . . . . . . . . . 59

5.2  Things To Do Next. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
5.2.1  Connecting netpad To The PC And Using PsiWin . . . . . 56
5.2.2  Backing Up To Multimedia Cards . . . . . . . . . . . . . . 57
5.2.3  Exploring The Control Panel . . . . . . . . . . . . . . . . 58
5.2.4  Power and Power Saving Mode . . . . . . . . . . . . . . . 59
5.2.5  Securing Your Information. . . . . . . . . . . . . . . . . . 62

5.3  Customizing Your netpad . . . . . . . . . . . . . . . . . . . . . . . . . 62
5.3.1  Creating Your Own Wallpaper . . . . . . . . . . . . . . . . 62
5.3.2  Recording Your Own Alarms . . . . . . . . . . . . . . . . 63
5.3.3  Customizing The System Screen . . . . . . . . . . . . . . 64





Psion Teklogix netpad EPOC User Manual 53

Chapter 5: Configuring The netpad
Things To Do First

5.1  Things To Do First
This section describes what you may need to do to set up your netpad:

• Enter owner information, so that your netpad can be returned if you lose it.

• Set a passcode for your machine, so that other people cannot access 
your information.

• Set the current time and date, so that you can use the diary program Agenda 
and set alarms.

• Set your “Home city”, so that the netpad can display the correct time differ-
ences and dialling codes for other places in the World. This is useful if you 
use the Time program.

5.1.1  Entering Owner Information
It is a good idea to type your contact information as “owner information”, so that if 
you lose your netpad, it can be returned when found:

1. Select the Passcode icon from the Control Panel in the System screen, 
and tap the Owner info button in the dialogue (see “Setting A System 
Passcode”, below).

2. Set how you wish the owner information screen to be displayed:

At switch on, if you always want to display the screen when switching 
the machine on.

Once per day, if you only want to see the screen once a day, the first 
time you switch your machine on each day.

Never, if you never want to display the screen when you switch on.

3. Type in your details and tap Done. The labels provided are suggestions 
only; you can change them if you want to. It’s best not to put your home 
address, in case your house keys are lost at the same time.

You can display the owner information at any time using the Owner command on 
the Information menu in the System screen.
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5.1.2  Setting A System Passcode
To prevent anyone from looking at the files on the Internal disk of the netpad, set a 
system passcode that you must type in before you can use the machine.

To set a system passcode:

1. Select the Passcode icon from the Control Panel in the System screen.

2. Check the Ask for passcode box so that your netpad requests the pass-
code when you switch the machine on.

3. Type the passcode twice for confirmation. Choose a passcode that you 
won’t easily forget, but one that won’t be easy for someone else to 
guess. DON’T FORGET your passcode! You will need to enter the 
passcode again if you want to change the passcode settings on 
your netpad.

The passcode is now set. The next time you switch your machine on, you will have 
to type in the passcode to access your files.
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If you want to switch the passcode off temporarily, remove the checkmark from the 
Ask for passcode box.

Note: The system passcode does not protect files stored on multimedia cards or 
files copied to other machines.

Important: Don’t forget your passcode! If you have forgotten the system pass-
code then you will have to reset the machine. All the files stored on 
the internal disk will then be lost.

5.1.3  Setting The Time, Date And Home City
1. In the System screen, tap on Control Panel on the Toolbar, or select the 

command from the Tools menu.

2. Tap the Time & date icon.

3. You will see a dialogue in which you can set the time and date, your 
home city and summer times around the world. Tap the Time & date 
button. Move the highlight in the Time and Date lines by tapping on the 
part you want to change, or by using the arrow keys. Type the date or 
time, press P for p.m. or A for a.m.

4. Tap on the OK button and the time and date are saved.

5. Tap the Home button.

6. Select your Home city and country. To do this:

• Start typing in the name of your home city, or tap on the arrow symbols 
or press the left and right arrow keys until you find the city you want.

• If your home city is not listed, select a city that is nearby for now 
(adding a city is described in the Time document).

• Tap on the OK button and your home city is saved. Tap Close to remove 
the dialogue and return to the Control Panel.

Note: The netpad can use a 12-hour clock (midnight is 12:00:00 a.m.) or a 24-
hour clock. Refer to the ‘Time’ document for details on how to change 
these settings, and how to adjust the clock for summer time.
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5.2  Things To Do Next
This section gives a brief overview of what else you may want to do when you first 
use your netpad, including:

• Instructions for using PsiWin to connect to your PC and perform backups to 
your PC.

• Ideas for customizing your netpad.

5.2.1  Connecting netpad To The PC And Using PsiWin
• Connect the cable to the serial port on the netpad, and the other end to a 

serial port at the back of the PC.

• Please see the Installing and Setting up PsiWin document for installation 
instructions.

• When you have installed PsiWin on the PC, the My Psion icon will appear 
on the Windows Desktop. Just click the right mouse button on this icon to 
see menu options for the things that you can do. PsiWin also adds a number 
of commands and icons to Windows Explorer for working on netpad files. 
For details on the use of PsiWin with the netpad, please refer to Chapter 7: 
“Connecting netpad To A PC”, and also see the PsiWin online help.

Note: A communications program, “Comms”, is available which provides ter-
minal emulation and file transfer to other computers. You can use it to 
connect the netpad directly to another computer, or via a modem to access 
electronic mail systems and bulletin boards. See the Comms User Guide 
for more detail.

Time & Date DialogueTime & Date Icon
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Backing Up To A PC
You can use PsiWin to back up individual files, folders, or the netpad’s entire disk to 
the PC.

Note:  Making regular backups.
It is a good idea to set up an “automatic backup” in PsiWin so that you 
can make sure your machine is backed up regularly.

5.2.2  Backing Up To Multimedia Cards
You can back up individual files, individual folders or groups of files and folders to 
a multimedia card fitted in the multimedia card (MMC) slot. To back up the files 
and folders, copy them from the internal disk to a multimedia card using the Copy 
and Paste commands in the System screen.

1. Select the files and folders you want to back up, then select the Copy 
command from the Edit menu.

2. Set the current disk to be D (i.e. the multimedia card), and select the 
folder you want to use for the backup on disk D.

3. Select the Paste command from the Edit menu.

Restoring Files From A Backup
To restore the files and folders on a multimedia card to your netpad, copy them from 
the multimedia card to the Internal disk in the same way as backing up. This time, 
set the current disk to D to select the files on the multimedia card, copy the selected 
files, then change it to C to paste the copied files to the Internal disk.
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5.2.3  Exploring The Control Panel
To display the Control Panel: 

Move to the System screen and tap on Control Panel on the Toolbar, or select 
the command from the Tools menu.

Initially, you should set up the Time & date, Screen, Power, and Printer if you 
intend to use one. You might also like to set up owner information and a passcode if 
you have not done so already. You may wish to change other settings later.

• Use the International icon to change settings that may vary from country to 
country, e.g. the currency and date formats.

• Use the Power icon to control how and when the netpad switches on and 
off. For example, you might like it to switch on when you tap the screen, 
and off when you haven’t used it for three minutes. For details, see “Power 
and Power Saving Mode” on page 59.

• Use the Sound icon to control the sounds that the netpad makes when you 
press navigation keys, tap the screen and perform other actions.

• Use the Screen icon to change the screen contrast and brightness, or 
re-calibrate the touch sensitive screen if the netpad stops responding to your 
pen taps.

• Use the Keyboard icon to control how long you have to hold a key down 
before a repeat keypress occurs.

• Use the Passcode icon to set a passcode on your machine or enter 
owner information.

Control Panel
Toolbar Button

Control Panel
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5.2.4  Power and Power Saving Mode
1. From the Control Panel, select the Power menu.

2. The following menu appears. Selection of Screen tap switch on places 
a checkmark in the white box. When this item is selected and the 
netpad has switched off, the netpad can be restarted by tapping 
the screen.
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3. Selection of Automatic switch off presents the following three options.

• Yes
This option will automatically switch off the netpad when the time set in 
the Switch off after box is reached, if there has been no user action on 
the netpad for that time period.

• No
The netpad will not switch off automatically.

• If no external power
This option will automatically switch off the netpad when the time set in 
the Switch off after box is reached, if there has been no user action on 
the netpad for that time period, and only if there is no external power.

4. Selection of Power saving mode presents the following three options:
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• Standard
This option will automatically switch off the netpad when the time set in 
the Switch off after box is reached, if there has been no user action on 
the netpad for that time period. 

• Standard (no radio)
This selection switches the netpad off in the same way as the Standard 
option, but also switches off the radio, with the result that there is no 
communication between the netpad and the radio. This option is used to 
turn off the radio when you are entering areas where radio emissions are 
not permitted, such as a plane or a hospital.

• Screen only
This mode switches off the LCD to save power, but enables the radio 
unit to switch it on for an incoming transmission from the radio network. 
Selection of the Screen only mode allows the user to select Beep on 
screen off and Clicks when screen is off. These functions are selecting 
by placing a checkmark in the white box (see details below).

Beep on screen off 
This selection will cause the unit to emit a loud beep if there has
been no user action or radio transmission when the time set in the
Switch off after option is reached.

Clicks when screen off 
Once the netpad has entered the Power Saving mode by 
switching off the LCD, the speaker on the netpad will click 
every second to let the user know the netpad is in the LCD power
saving mode.

If Beep on screen off and Clicks when screen off are not enabled, the 
netpad will switch off when the time in the Switch off after option is 
reached, but there will be no sound warning that the netpad is still active. 
The LCD will automatically come on with incoming transmissions to 
the radio.

To switch on the LCD with Screen only Power saving mode enabled: 

i)  Tap the screen if the netpad has Screen tap switch on enabled
 (see page 59).

ii) Press the On/Off button.
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To switch off the netpad with Screen only Power saving mode enabled: 

With the LCD on, pressing the On/Off button for longer that
three seconds will place the netpad into stand-by. The netpad
will not come on with incoming radio transmissions.

5.2.5  Securing Your Information
There are no known problems with passing the netpad through airport security 
machines and other X-rays.

There are several things that you can do to secure your files against other hazards. 
You can:

• Make your files “read-only”. For more information see Chapter 6: “Files, 
Folders, and Programs”.

• Back up your files regularly (see “Backing Up To Multimedia Cards” on 
page 57) in case they get lost or are deleted accidentally.

• Set passwords to protect information from prying eyes. You can set a pass-
word for the netpad as a whole (as explained earlier) or for individual files. 
For more information see Chapter 6: “Files, Folders, and Programs”.

• Enter contact information so that your netpad can be returned to you if you 
lose it. See “Entering Owner Information” on page 53.

Note: It is not possible for anyone to copy information from or to your machine 
using Infrared, unless they are able to access its Infrared ‘Send’ and 
‘Receive’ commands.

5.3  Customizing Your netpad
This section includes some ideas for customizing the netpad.

Note: You can customize the way many programs work using the Preferences
commands on the program’s Tools menu.

5.3.1  Creating Your Own Wallpaper 
You can change the “wallpaper” that appears in the background on the System 
screen. You can use any picture that you draw or import into Sketch.
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To create wallpaper:

1. Display the picture in Sketch. If you only want to use part of a picture, 
select the area.

2. Select Save as System wallpaper from the More commands on the 
File menu.

3. Type a name for the wallpaper file. Sketch keeps the files that contain 
wallpaper separate from the original Sketch files so you can carry on 
using your original picture without affecting the wallpaper.

To select the wallpaper file to use:
Move to the System screen and select Preferences from the Tools menu. Move 
to the Wallpaper page and select the name of the wallpaper file that you want 
to display.

To delete a file containing wallpaper:
Move to Sketch and select Delete System wallpaper from the More commands 
on the File menu. Select the wallpaper that you want to remove. 

Note: You cannot delete the built-in wallpaper included with the netpad.

5.3.2  Recording Your Own Alarms 
You can use the Record program to create alarm sounds that can be used in Time 
and Agenda.

To save a recording for use as an alarm sound:
Select the Alarm sound button on the Toolbar or the Save as alarm sound
command from the File menu and type a name for the alarm sound. This creates 
another version of the sound as an alarm, and leaves the original file open 
in Record.
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To delete a custom alarm sound:
Select the Delete alarm sound command from the File menu, and select the 
alarm to delete from the list. 

Note: You cannot delete or modify the built-in netpad alarm sounds.

5.3.3  Customizing The System Screen 
In the System screen, you can use the commands on the View menu to change how 
the System screen looks and works:

• Change the position of the Title by selecting Title position, and the width 
of the columns by selecting Column width.

• Use Zoom in and Zoom out to change the size of text and icons on screen so 
that more or fewer files and folders are displayed.

• Turn the Toolbar off and on with Show toolbar; without the Toolbar you can 
see more of the System screen.

• Control how the files are sorted, and what file information is displayed with 
Sort files and Show file details. When you first use the netpad, files are 
grouped ‘by type’ (i.e. according to program); you can change this to sort 
them by date, name or size.

You can customize many of the ways that the netpad works from the System screen 
using the Preferences command and the icons in the Control Panel. For example, 
you might want to change the automatic switch off setting, owner information, the 
standard printer and print preview settings, and set up a password to protect your 
files from prying eyes.
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You can customize the positions of icons on the Program icon bar, e.g. so that the 
icons for your favourite programs appear in particular positions. To display the 
Program icon bar where you can set this, press the System icon once if you are in 
the System screen, or twice if you are in an application. To display the dialogue in 
which you set the position of an icon, tap the title bar on the left-hand side.

The System screen preferences allow you to display “hidden” files and the ‘System 
folder’ in the System screen, change the standard folder for files, and change the 
keypress for opening multiple files.

Warning: The System folder contains files that are used by the netpad pro-
grams themselves. You should not normally need to access these 
files, which is why this folder is not shown as standard. Do not 
delete or modify files in this folder, or create new files in this folder, 
otherwise you may have problems using the netpad programs.
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6.1  Introduction
The System screen is the netpad’s file manager. You will see the System screen the 
first time you switch the netpad on; at other times, just tap the program icon. Alter-
natively, tap the open program to display the Open files/program dialogue. Then 
select System and Go to file to move to it. 

Note: When you first turn the netpad on, the name of the current folder is dis-
played in the Title at the left of the screen. If any files are present, they are 
listed in columns across the screen; the icons beside their names represent 
the programs that are used to open them.

Displaying Online Help
To display online help, select the Help option from the Tools menu from the System 
screen. This provides help on files, folders and programs. 

6.2  Moving Around 
To move the highlight between the files and folders on the screen: 

tap on the names, or use the arrow keys. If there are more files in the folder than 
can be displayed on screen, scroll the screen using the scroll bar.

You can use a “bookmark” to tag and move to a folder that you often use. Move to 
the folder and select Set bookmark from the Edit menu to insert the bookmark. 
Later you can select Go to bookmark from the Edit menu to move back to 
the folder.

1. Tap program icon

2. Select System and tap Go to file



Chapter 6: Files, Folders, and Programs
Opening Files, Folders And Programs

70 Psion Teklogix netpad EPOC User Manual

To view the files on a multimedia card: 
change the current disk by tapping the disk (C) icon in the Title bar and select 
the disk you want to view, or select the command for disk D from the Current 
disk command on the Disk menu.

6.3  Opening Files, Folders And Programs 
To open a file or folder from the System screen: 

tap it twice, or highlight it and press Enter. Files that are currently open have 
their names displayed in bold on the System screen. Opening a file automatically 
saves and closes any other file that is currently open in the associated program.

To move to a program: 
tap the relevant program icon. Tap the System command icon to display the 
Program icon bar with more program icons. If the program is file-based, e.g. 
Data or Word, the program displays the last file you were looking at. You can 
start a new file using the New file Toolbar button or the command on the File 
menu (see “Creating New Files” on page 72 for more details).

Notes: If the last file you were looking at has been deleted, moved or renamed, 
the program automatically looks for a file with a standard file name (e.g. 
Word, Data, Agenda and so on) in the standard folder, and opens this file 
instead. It will create a new file if necessary.

Tap on the System command icon to display icons for additional programs 
installed on your netpad. If there are more programs than will fit on the 
screen, tap the More button.

Current Program NameFilesClose Folder

Memory
Information

Change Disk



Psion Teklogix netpad EPOC User Manual 71

Chapter 6: Files, Folders, and Programs
Closing Programs/Files

How can I see which files and programs are open?
Select the List open files command on the List cascade from the File menu, or tap 
the System icon. To move to a file or program in the list, highlight it and press the 
Go to file button.

6.4  Closing Programs/Files 
To close the current folder: 

tap on the Close folder icon at the top of the screen, or highlight it and press 
Enter. When you close all folders in the System screen, you move to the highest 
level of the disk, called the “root” of the disk.

To close a file: 
use the Close command on the File menu, either in the program in which the file 
is open, or in the System screen. Any changes you have made to the file are 
automatically saved.

To close a document without saving your changes: 
select Revert to Saved from the program’s File menu, in the More option, 
before exiting in the normal way. Some applications, like Agenda and Data, 
always save your entries as you enter them, and therefore do not provide 
this facility. 

You can also close files or programs by selecting the list of open files and programs 
by tapping the current program name, then using the Close file button in the list of 
open files and programs.

6.5  Creating New Folders
You can keep a maximum of 64 items (each file or folder counts as one item) in the 
“root” (top level) of the netpad’s internal disk. It’s best to create a number of folders 
in which to store all your files to prevent the top level of the System screen from 
becoming too full.

You might want to create some folders for work projects and others for home use. 
For example, you may create a folder called “House” for files relating to work on 
your house, and create another folder within the “House” folder called “Letters” for 
Word files of correspondence. Using folders in this way will also make your files 
easier to find.
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To create a new folder:

1. Move to the folder in which you wish to create the new folder.

2. Select the New folder command from the Toolbar or File menu, and 
type in the folder name.

You cannot use the following characters in a folder name: < > : / \ *?

If you use netpad files with a PC, you may wish to create folders that match equiva-
lent folders on your PC. This will make transferring files between the netpad and 
PC easier.

6.5.1  Creating New Files 
You can create files from the System screen, or from within programs. As a general rule:

• Create a file from the System screen to start with the standard netpad settings.

• Create a file from within a program to use the settings that are in use in the 
file currently open, e.g. labels in a Data file.

To create a file from the System screen:

1. Move to the folder where you wish to keep the file.

2. Select the Create new command from the File menu, then select File.

3. Select the program you wish to use, e.g. Word for a Word document.

4. A filename is suggested. If you do not wish to use this, type a name of 
your own before pressing the OK button.

What names can I use for my files & folders?
You can use most characters in file and folder names including spaces, for example, 
“1997 Purchase Orders and Invoices”. The only characters which cannot be used in 
a file or folder name are / < > : \ * and ?.

The maximum length of a filename is 256 characters, although note that this 
includes the disk drive letter, and the names of the folders within which the file is 
contained (known as the “path”). The maximum length of a folder name, including 
the path, is 252 characters.
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Generally, this will not be a problem, although it means that you may encounter dif-
ficulties if you use very long filenames for files which you store in folders which 
have long names, nested within other folders with long names, and so on. If you do 
exceed the maximum allowed length, rename a folder or file to a shorter name.

Important: Note that files are not stored with a file name extension so that an 
Agenda file, e.g. called ‘1997’, will have the same file name as a 
Sheet file called ‘1997’. You cannot store two files with the same 
name in the same folder, even if the files are created using different 
programs. If you save a file with the same file name as a file already 
existing in that folder, the original file will be deleted and replaced 
with the new file.

6.6  Browsing Folders 
A quick way to find a file is to use the Browse folders command on the File menu. 
This displays a Browser which shows a tree structure of all the files and folders on 
the current disk. You can also display the Browser by tapping the Title bar or press-
ing Tab in the System screen.

To move between files and folders in the Browser: 
use the pen or arrow keys.

To “expand” the folder display: 
highlight the folder name and tap it again or press Tab. To “collapse” the folder 
display, tap the folder name twice or press Tab.

To create a folder from the Browser: 
press the New folder button.

To rearrange the order of the files in the currently highlighted folder:
press the relevant Sort by button.
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To select a file from the Browser: 
highlight the file and press the OK button. This selects the file in the System 
screen from where you can open it, rename it, or copy, move or delete the file.

6.7  Finding Files And Folders 
To search for files or folders tap the Find file button on the Toolbar or select the 
command on the Edit menu.

• If you know the name or part of the name, type it on the Name line; leave it 
blank to find all files and folders.

• To search only for files used with a specific program, select the program 
name on the Program line; select Any to search for all files used with 
any program. 

• Tap OK to start the search. 

This checks all files and folders on the Internal disk and includes a multimedia card 
if present. The search results appear in a list.

To sort the list: 
by filename, file type, file size or creation date, press the Sort button and choose 
the sorting type required. To sort the list again in reverse order, just select the 
same sorting type again.

To go to a file or folder: 
highlight it and tap it again, or press Enter.

Sort Files By...Folders

Files
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6.7.1  Using Passwords 
You can prevent other people from opening your Word and Sheet files by setting a 
password for each file. For example, you may have a Sheet spreadsheet containing 
your personal finance details. To set a password on a file:

1. Open the file and select the Password command from the File menu.

2. Type your password twice for confirmation. Choose a password that 
you won’t easily forget, but one that won’t be easy for other people 
to guess.

3. Press the OK button, and the file is saved immediately with the pass-
word.

When you want to open the file, you will be asked to type in the password.

Important: Don’t forget your password! If you have forgotten the password for 
a file then you will not be able to open it.

The password on an individual file will protect it if you transfer it to 
a multimedia card or another machine. If you copy the file, the copy 
will be protected by the same password. The password also prevents 
the file being converted to another format and read on a PC.

6.8  Changing File Attributes 
You can prevent a file from being accidentally changed by making it a “read-only” 
file. To do this, highlight the file in the System screen and select Properties from 
the File menu. Then check the Read-only box.
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Files that have been created on a PC and then transferred to the netpad may also be 
“read-only” files.

To check whether a file is a “read-only” file, highlight it in the System screen and 
select Properties from the File menu.

Note: If you transfer a “read-only” file to another machine, it can be viewed, 
and the “read-only” attribute can be removed.

6.9  Managing Folders 
To move one or more folders or files from one location to another:

1. First highlight the file(s) or folder(s) to select them. Drag with the pen 
to select more than one file.

To select all the files/folders in the current folder, use the Select all 
command on the Edit menu. To deselect items, press the Esc key.

2. Select the Cut (move) command from the Edit menu. A dotted line 
appears round the file/folder icon(s).

3. Go to the disk drive and open the folder into which the highlighted 
items are to be moved.

4. Select the Paste command from the Edit menu.

Notes: Moving a folder also moves all the files within that folder.

If you move (or rename) your most recently opened Agenda or Data file, 
you should open it again by selecting it from the System screen, rather than 
tapping the Agenda or Data program icon. Tapping on the program icon 
will create a new Agenda or Data file.

To copy a file or folder, or multiple files/folders to a different folder: 
follow the earlier instructions, but select the Copy as opposed to the Cut (move) 
command from the Edit menu.
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To make a copy of a file or folder within the same folder: 
highlight it on the System screen and select the Copy command followed by the 
Paste command. A new file is automatically created for you using the following 
naming convention (with Word as the example): Word(01), Word(02), etc. You 
can rename the file or folder later if you wish.

To copy the entire contents of a disk to a folder on another disk: 
e.g. to back up the entire contents of your Internal disk (C) to a backup folder on 
a multimedia card (D), select Copy disk from the Disk menu.

To rename a single file or folder: 
highlight it, select Rename from the File menu, and then type in a new name.

To rename a disk: 
select Name disk from the Disk menu.

To remove one or more files or folders: 
first highlight them and then either press the Delete key, or select the Delete 
command from the File menu.

Important: If you are deleting folders, remember that the entire contents of the 
folders (including all the other folders contained within them and 
all their files) will also be deleted.

6.10  Checking Memory Use 
To display the amount of memory remaining: 

select Show disk gauge from the View menu to see the amount of free memory 
in the System screen Title bar. Tap on this gauge, or select the Disk command 
from the Information menu to see more detailed information about a 
selected disk.

Disk Gauge
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To see information about total memory usage: 
select the Memory command from the Information menu.

6.10.1  Which Files Use The Most Memory? 
Certain types of files use more memory than others. 

Sound files can become very large, so you should take care to delete unwanted 
Record and Voice note files so that they do not use up space on the Internal disk.

When recording a sound, the netpad will allow you to continue recording until the 
‘Time available’ runs out. Even if the Time available is zero, the Record program 
will always leave approximately 100 kilobytes of free memory. 

If you find that the amount of free memory is suddenly reduced, it is a good idea to 
check the size of any Record files. 

Agenda files can also become very large. You should tidy your Agenda periodically 
in order to remove entries; see the Agenda User Guide document for more details.

What will happen when the memory is full?
When the memory is nearly full, you will see warning dialogues when running pro-
grams to indicate that the netpad’s memory is almost full, and there is not enough 
memory to perform some tasks.

Many of the things you do need just a little free memory in order to work—display-
ing dialogues, menus, etc. These can fail with a message like ‘Memory full’. Don’t 
worry though, the netpad will not allow you to use all of the available memory; it 
will always set aside enough memory for you to close a program or save an open file 
to a multimedia card.
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Files saved on the Internal disk and “open” programs both use memory. So, if the 
memory is nearly full you should be able to free some memory by closing some pro-
grams. You can use the List open files command from the File menu in the System 
screen to check which programs are running, and then close the programs or files 
that you do not need to have open.

You can also delete any unwanted files from the System screen, or move files to a 
multimedia card or your PC to free more memory.

6.10.2  Additional Memory And Programs
You can insert multimedia cards into the slot on the right-hand side of the netpad. 
You might use them as additional memory for storing files, or to add more programs 
to the netpad.

If a multimedia card contains additional programs: 
their icons will automatically appear in the Program icon bar when you insert 
the disk. They will be removed when you take out the card.

To delete all the files on a multimedia card: 
put it in the slot, and then select the Format disk command from the Disk 
menu; select D a s the ‘Disk’ in the Format disk dialogue. 

Important: Do not format the C disk - this will remove all the files you have 
stored on the netpad’s internal disk, and remove all the preferences 
and settings that you have set up.

Translated OPL programs that have not been made into applications will not appear 
in the Program icon bar. If you wish to run a translated OPL program, locate the file 
in the System screen, highlight the filename and tap it or press Enter to run it.

Can I run Series 3/3a/3c/3mx/5/5mx programs on a netpad?
There are no major differences between OPL for Series 3/5 machines and OPL for 
the netpad. If you have written programs in OPL on a Series 3/5, you should be able 
to translate them so that you can run them on a netpad. Series 3/3a/3c/3mx applica-
tions (which are not written as OPL programs) will not run on a netpad; however, 
applications written for Series5/5mx should work.
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7.1  Introduction
This chapter explains how to use PsiWin to copy files between a PC and netpad, and 
how to synchronize files such as Agenda, Data and Contact files. It assumes some 
basic knowledge of Windows 95/98/NT4. 

The chapter assumes that you have established a link between your PC and netpad. 

• Check this by looking in the PC’s System tray in the bottom right-hand 
corner of your desktop. There should be a wiggly line in the system tray if 
you have successfully linked, as shown. 

If this line is straight there is no connection. 

• Make sure that your link cable is connected. 

• On the netpad, go to the System screen and select Link to desktop… on the 
Tools menu. Make sure that the Link line is set to Cable. 

If you are having problems connecting to your netpad, please see “General Trouble-
shooting Tips” on page 165, or if docked check to make sure the RS-232 cable is 
connected to the docking station.

For information about installing PsiWin, see the document, Installing and Setting 
Up PsiWin. For information about printing to a PC printer via PsiWin, see “Using 
PsiWin To Print Via A PC” on page 153.

7.2  About PsiWin 2
You can use the PC connectivity software, PsiWin 2, to integrate the netpad with 
PCs running Windows 95/98/2000/ME or NT 4.0. By connecting the netpad to a PC 
with a cable and running PsiWin on the PC, you can:

• View your netpad files from Windows Explorer by using the ‘My Psion’ 
icon which is added to the PC’s Desktop. The ‘My Psion’ icon gives you 
access to all of PsiWin’s powerful file management facilities for your 
netpad files.
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• Drag and drop files between the netpad and the PC in the same way that 
you would between PC drives, and they will be automatically converted to 
the appropriate file format at the same time.

• Synchronize Agenda files and your address book on the netpad with PC 
agendas (applications) and contact managers to keep them in step with 
each other.

• Back up your netpad files to the PC, then restore them from the PC to the 
netpad again should you ever need to.

• Print files on your netpad to a printer connected directly to your PC, or 
available to your PC via a network.

7.3  Using PsiWin
PsiWin is not a separate program; instead it allows Windows Explorer to see files on 
your netpad, using the My Psion icon. You can copy your netpad files in most of the 
ways you can copy any normal PC file. The two methods outlined in this chapter are 
representative of ways that you might use Explorer, but are not the only possibilities. 

Note: You can change the look of Explorer using options in the View menu; 
therefore, the appearance of your own screen may vary slightly from 
those shown. 

7.4  Getting Help 
7.4.1  Where Can I Find More Help? 
PsiWin includes comprehensive online Help, which describes all of the application's 
features and functionality. Please consult the online Help for further information or 
guidance on using PsiWin.

You can display the help topics by:

• Selecting Start, then Programs, then PsiWin 2.x, then PsiWin Help.
• Selecting the My Psion icon in Explorer and pressing the F1 key.
• Double-clicking on My Psion and selecting Help, then Help Topics from 

the Menu bar.

Note: You can display help for a particular task or dialogue by pressing the
<F1> key or clicking on the Help button.
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7.4.2  Tips On Using PsiWin Help 
From the Help Topics window, you can find the information you require as follows:

From the Contents page
you can select a topic from a structured list, e.g. how to perform a particular 
task, or troubleshooting information about how to solve a problem. To find the 
topic you want, double-click on the topic folders  to find the general area 
of interest, and then choose the topic you want to display.

From the Index page
you can find the topic you want by entering any word linked to the subject, such 
as ‘backup’ to find topics containing information about how to back up 
your netpad.

From the Find page
you can search for an exact word or phrase contained within a topic, such as 
‘serial port’ to find all the topics in the online Help containing this phrase.

Note: To provide further assistance, help topics may also include a Related Top-
ics button  providing links to other help topics covering similar subjects.

7.5  Working With Your Files 
7.5.1  Looking At Files On Your netpad 
Using My Psion and Windows Explorer, you can 
open, move, copy and delete files stored on your 
netpad from your PC.

• Double-click on the My Psion icon on 
your Desktop. The My Psion window 
opens, displaying icons for your netpad's 
internal drive(s) and other PsiWin features 
and settings.

• Double-click on a drive icon to display the 
files and folders on the drive.
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7.5.2  Copying A File Using Drag And Drop 
1. Open Windows Explorer:

• Click the Start button and select Windows Explorer from the 
Programs menu.

The left-hand pane of the Explorer window shows a list of all the disk 
drives on your PC, along with netpad and network drives (if any). You can 
expand a branch by clicking on the  symbol next to it, or close the 
branch by clicking on the  symbol. The right-hand side of Explorer 
shows the contents of the folder selected on the left.

2. Use the scroll bar on the right of the left-hand Explorer pane until you can 
see the drive that contains the folder that you want to copy the file to. 

3. Using the  and  symbols and the scroll bar, expand the folder 
list until you can see the folder that you wish to copy the file into. 

4. Click on the folder to select it.

5. Double-click on the My Psion icon  on your Windows 
desktop to open the My Psion window.
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6. The icons to the left of the window (in this example, Internal and NO 
NAME) represent disks on your netpad. 

7. On your netpad browse to the 
folder that contains the file you 
wish to convert to the PC. Do this 
by opening the appropriate disk 
icon and then the relevant 
folder name(s).

8. Open the folder. You see icons 
for each of your files. The icons 
correspond to the type of file.

9. Rearrange the positions of the My Psion and Explorer windows until 
you can see both of them at the same time.
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10. Click on the file you want to copy and, keeping your finger on the left 
mouse button, drag the mouse pointer over the right-hand pane of the 
Explorer window.

11. Drop the file over this area by releasing the left mouse button.

12. When the Select type of conversion… dialogue appears, select from a 
list of appropriate conversion types by clicking on the  button.

13. Click the Convert button.

The file is converted into the selected PC format and can be used in the same way as 
any other file on your PC.
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7.5.3  Copying A File Using Copy And Paste 
Using Windows Explorer, you can copy files between your PC 
and netpad in the same way you would copy files to a floppy 
disk, or another PC on a network. PsiWin can convert files as 
they are copied so that you can open them on the other com-
puter straight away.

Within Windows 95, 98 or NT4, clicking the right mouse 
button often displays a context-sensitive (pop-up) menu – a 
range of commands relevant to the object which you right-
click on. In Explorer, you can use these menus to copy files 
between folders, regardless of whether they are on the PC or 
the netpad.

1. Open Windows Explorer.

2. Navigate to, and expand, the My Psion branch of the folder list. Find 
the folder that contains the file you wish to copy to the PC and click on 
it so that its contents are shown in the right-hand pane of the 
Explorer window.

3. Right-click on the file and select Copy from the pop-up menu that 
appears.
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4. Navigate to the folder you want to copy this file to, and select it, so that 
its contents (if any) appear in the right-hand pane of the Explorer 
window. Right-click in the right-hand pane of the Explorer window, 
and select Paste from the pop-up menu.

5. As PsiWin copies the file, a dialogue box appears in which you can 
select the type of file you wish to use on the other computer.

6. The dialogue suggests a suitable file type for the converted file, e.g. 
Excel 5.0/95 for a netpad Sheet file, or Word 6.0/95 for a netpad Word 
file. Select an alternative type if you use a different file type on your PC

7. Select the Convert button to copy the file from your netpad to the PC 
and automatically convert it into the chosen file type.

Note: You can select the Help button for more detailed help on the features of 
this dialogue box.

You can use Windows Explorer to manage files and folders stored on your netpad in 
the same way as you can on your PC’s drives.

Warning: When you delete a file on your netpad from your PC, it is perma-
nently removed from the netpad’s drive. The file cannot be retrieved 
from the Windows Recycle Bin, which only stores files deleted from 
your PC’s drives.

Further help: See the online Help for more information on how to manage files, 
folders and disks.

Note: You can also copy the file by clicking on the file icon and dragging it to 
the folder on your PC.
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7.5.4  Opening netpad Files From Your PC 
You can open a file on your netpad using a PC application without first having to 
copy it to your PC drive. You can edit the file on your PC and then save it back to 
your netpad when you have finished.

1. To open a file from Windows Explorer, double-click on the file icon or 
press Enter. A dialogue box appears in which you can select the type of 
file you wish to use on your PC.

2. Select the file type suitable for the application you will use to edit the 
file on your PC.

3. Click on the Convert button to copy the file and convert it to the 
chosen PC file type. PsiWin opens the converted file using the PC 
application associated with the file type, e.g. Paint for a Bitmap Image 
(*.bmp) file, or Notepad for a Text (*.txt) file.

When you save the file within the PC application, PsiWin saves the edited file back 
to your netpad. A dialogue box appears which allows you to select the file type for 
the edited file. Select the appropriate file type for your netpad, and then select 
Convert to copy the file back to your netpad. PsiWin makes a backup copy of the 
original file, which is renamed with a ‘.bak’ suffix, e.g. a file named ‘Document’ is 
backed up as ‘Document.bak’.

Important: Don’t delete the backup version of the file from your netpad until 
you are sure you want to use the edited version instead.

Further help: See the online Help for more information on how to open netpad files 
on your PC.

7.6  Backing Up Your netpad With PsiWin
7.6.1  Performing Your First Backup 
You can use PsiWin to back up all the files stored on your netpad to your PC. 
Keeping backups of your netpad files on your PC means that you have a separate 
copy of all your work that can be restored to your netpad. For example, you can 
restore backed up files to your netpad if you accidentally delete a file, wish to revert 
back to an older version of a file, or need to restore files if you forget to change
the batteries.
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To make a backup:
1. Double-click on the Psion Backup icon on the Desktop.
2. In the Psion Backup dialogue, select the drive(s) on your netpad you 

wish to back up.

3. Click Back Up to start backing up the files on your netpad. PsiWin dis-
plays a progress window showing how long the backup will take and 
will inform you when it has completed.

Further help: See the online Help for more information on how to back up and 
restore your netpad files.

7.6.2  Scheduling Regular Backups 
You can set PsiWin to make automatic backups at regular intervals so you do not 
need to remember to back up your netpad. It is a good idea to schedule automatic 
backups because it means you will always have up to date copies of your 
netpad's files. 

To schedule regular backups:

1. Right-click on My Psion and select Properties.

2. Move to the Backup tab.

3. Click on Perform automatic backup and select how often you wish to 
backup your netpad.

Further help: See the online Help for more information on how to schedule regular 
automatic backups.

7.7  Synchronizing Your netpad 
7.7.1  What Is Synchronization? 
You can use synchronization to manage information that you wish to keep up to date 
on both your PC and netpad, such as agenda appointments or an address book. 
When you synchronize, PsiWin checks the information in your PC scheduler with 
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the matching Agenda or Data file on your netpad, and then updates the files on both 
your PC and netpad to include the new information. Some examples of synchroniza-
tion are:

• You add a new appointment in your netpad Agenda, the date, time and 
notes for the entry will be copied to your PC scheduler.

• You change a phone number in your PC scheduler; it will be amended in 
your netpad’s address book.

• You enter overlapping appointments in your PC and netpad agendas, 
PsiWin will warn you of the conflict.

Many people will just use one synchronization task to keep their netpad information 
in step with their PC information. Synchronization tasks can be used in a number of 
other ways, for example:

• You and other colleagues could synchronize their work Agendas with the 
same master scheduler on a networked PC.

• You may have a work Agenda synchronizing with a network installation of 
Organizer at the office, and a personal Agenda synchronizing with Sched-
ule+ on your PC at home.

The following sections provide instructions for synchronizing with Microsoft Out-
look, Microsoft Schedule and Lotus Organizer. 

7.7.2  Synchronizing Your netpad With Microsoft Outlook
This chapter details the set-up and day-to-day use of PsiWin to synchronize your 
netpad Agenda and Data files, or the Contacts program, with Microsoft Outlook 
97/98 on the PC. The chapter assumes some familiarity with the use of Windows 
95/98/NT 4.0.

7.7.2.1 Software Compatibility
This chapter assumes that you are using PsiWin (supplied with netpad). You must 
also have a full local installation of Microsoft Outlook 97/98.
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7.7.2.2 Creating New Synchronizations
If you have different Agenda or Data files, or Outlook folders that you want to syn-
chronize, you can create multiple synchronizations on your PC. You must define at 
least one synchronization.

Required Information
Before creating your synchronization, note the locations of the Agenda, Data or 
Contacts files you want to synchronize. The synchronization needs to know which 
particular files you want to use. You must also specify which folders within Outlook 
to synchronize.

• If you are synchronizing an Agenda or Data file, open the file(s) that you 
want to synchronize. 

• Tap the file name at the top of the toolbar to open the Open files /programs 
dialogue.

•  Scroll through the list until you find your file(s) listed. 

• Make a note of the path (in this example, c:\Documents\Agenda).
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7.7.2.3 Creating The Synchronization
Important: It is very important that the following information is entered cor-

rectly – otherwise, the wrong files may be synchronized, or no syn-
chronization will occur. However, if you do not have an existing 
Agenda or Database file on your netpad, the synchronizer can 
create them. This is especially useful for a Contacts database – if 
you specify a non-existent Data file, the synchronizer creates a new 
one on the netpad that is optimized for use with your Outlook con-
tacts. The synchronization can only create a Data file if you have 
select the option to synchronize a Data file.

1. Make sure that your netpad is connected to the PC. 

2. Double-click on the My Psion icon. Assuming the 
machines have linked successfully, you will see several 
icons, including one labelled Psion Synchronizer.

3. Double-click on this icon.

4. In the Psion Synchronizer window, click the New button. This launches 
the Psion Synchronizer Wizard, which will take you through the steps 
required to set up the synchronization. If you have never created a 
synchronization before, PsiWin will bypass this window and go straight 
to the Synchronization Wizard.

The welcome screen of the Wizard asks you the PC PIM that you want to synchro-
nize with.
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5. Highlight the relevant option and click the Next button.

6. In the Psion section of the Applications dialogue, specify the netpad 
files that you want to synchronize with. 

a. To synchronize an Agenda file, make sure that the Synchronize My 
Agenda box is checked off. Then specify the Agenda file to be synchro-
nized. Either type in the path and file name you noted earlier, or click the 

button to browse the netpad’s disks. If in doubt, use the browse 
button to find your file.

b. To synchronize a Data 
file or the Contacts pro-
gram, make sure that the 
Synchronize My Con-
tacts box is checked off.
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c. To synchronize with the Contacts 
program, leave the next box as 
Contacts program.

To synchronize with a Data file, 
click the  button. Select 
Data and specify the Data file to 
be synchronized. Either type in 
the path and file name you noted 
earlier or click the  button to 
browse the netpad’s disk(s). If in 
doubt, use the Browse button to find your file. Next, click the 
OK button.

7. Enter details for Microsoft Outlook. 

• To synchronize the standard Outlook folders, leave all the Use 
Default… boxes checked off. 

• To synchronize custom Outlook folders, uncheck the relevant Use 
Default… box and enter the folder path.

You can find the folder path by looking at the Folder List in Outlook. If 
this isn’t shown, select Folder List from the View menu. Expand the list 
until you can see the folder you want to synchronize. The path will be 
the top level folder, then the subfolder that contains the folder(s) to syn-
chronize, and then the folder to synchronize. These should be separated 
by backslashes (\). If the name of your top level folder contains some 
text in square brackets, use this text instead of the top level folder name.
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In the example shown here, the path to the Example folder is Personal 
Folders\Calendar\Example.

Enter this information into the Applications dialogue of the Synchroni-
zation wizard. Uncheck the relevant Use Default… box, in this 
example, Use Default Calendar Folder, and type the path into the box 
(in this example the Calendar Folder box).

8. Click on the Next button.

9. Click on the Exchange Settings… button, enter a profile name and 
click the OK button if you want to synchronize with an Outlook profile 
other than your PC’s default.
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10. The next dialogue 
allows you to specify 
which types of entry 
you want to synchro-
nize. Uncheck particular 
entry types if you do not 
want them to be syn-
chronized.

11. Click the Next button 
when you have selected 
the entry types.

12. To specify the time 
period to synchronize, 
click the Set date 
range button, select the 
period required and 
click the OK button.

To specify how the syn-
chronization will deal 
with entries outside of 
normal working hours, 
select the appropriate 
option from the Agenda 
entries to synchronize 
section. You can also 
change your work hours 
by clicking the Set 
work hours button, 
altering the settings as 
appropriate and clicking the OK button.
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13. Click on the Advanced button to set up the label mapping. Note that if 
you are synchronizing with the Contacts program, or have chosen not 
to synchronize a Data file, you may not be able to click this button. In 
this case, you should ignore step 14 below and click the Next button.

14. The Contacts Synchronization dialogue lists the labels for the Contacts 
folder in Outlook (or whichever folder you have specified for contacts 
information) in the Contact information column, and in the Psion label 
column you can match these to their equivalents (if any) in your netpad 
Data file. To match labels:

a. Find the Outlook label whose function is the same as one of your netpad 
Data file’s labels, then click in the box next to it in the Psion label 
column.

b. An arrow  appears 
to the right of this box. 
Click on this to display a 
drop-down list contain-
ing all the Psion labels 
that you have not 
matched. Select the 
label you want to assign.

c. If you do not want to 
synchronize with a par-
ticular Outlook Contacts 
label, select <Ignore> 
from the drop-down list.

Note: Each Psion label can only 
be matched to one 
Outlook label.

15. When you have finished 
matching the labels, click 
the OK button and then the 
Next button.
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16. In the confirmation 
screen, click on the Syn-
chronize Now button to 
start the synchroniza-
tion process immedi-
ately; otherwise click on 
the Finish button to 
complete the set-up and 
save the synchroniza-
tion.

If this is the first time 
you have run the syn-
chronization, you may 
see the Contacts Syn-
chronization dialogue 
described above. If there 
are any labels on the 
netpad that cannot be 
directly mapped, the synchronization prompts you to do this by hand.
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7.7.2.4 Multiple Synchronizations
It is possible to synchronize more than one Agenda and Data files or Outlook folders 
by setting up multiple synchronizations. To do this, you may need to create extra 
Outlook folders. 

1. Select New, then Folder… 
from the File menu. 

2. Type in a name for the new 
folder. 

3. Select the type of items to be 
stored in the folder (in this 
example, Contact Items).

4. Select the folder to create the 
new folder in.

5. Click the OK button.

When you create the synchronization, enter 
the appropriate paths and file names in the 
applications dialogue.
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7.7.3  Synchronizing Your netpad With Microsoft Schedule+
This section details the set-up and day-to-day use of PsiWin to synchronize your 
netpad Agenda and Data files or Contacts program with Microsoft Schedule+ 7.0, 
7.0a or 7.5 on the PC. The chapter assumes some familiarity with the use of 
Windows 95/98/NT 4.0.

7.7.3.1 Software Compatibility
The details for this section assume that you are using PsiWin version 2.3. To check 
which version of PsiWin you have, double-click the My Psion icon, and select 
About PsiWin 2.x from the Help menu. If you have at least Build 97, then you have 
version 2.3.

You must also have a full installation of Microsoft Schedule+ version 7.0, 7.0a,
or 7.5. 

Note: You cannot use the Synchronizer with other versions of Schedule+.

7.7.3.2 Creating New Synchronizations
You can create multiple synchronizations on your PC if you have different Agenda, 
Data or Schedule files that you wish to synchronize. See “Multiple Synchroniza-
tions” on page 110. You must define at least one synchronization in order to syn-
chronize files.

Required Information
Before creating your synchronization, note the locations of the files you wish to syn-
chronize: the synchronization must be told which files to use.

1. If you are synchronizing an Agenda or Data file, open the file(s) that 
you wish to synchronize.

2. Tap the program name at the top of the toolbar. You will see the Open 
files / programs dialogue.

3. Scroll through the list until you find your file(s) listed. Make a note of 
the path (in this example, c:\Documents\Agenda). 
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7.7.3.3 Creating The Synchronization
1. Make sure that your netpad is connected to the PC, and 

then double-click on the My Psion icon. Assuming the 
machines have linked successfully, you will see several 
icons, including one labelled Psion Synchronizer. 

2. Double-click on this icon.

3. In the Psion Synchronizer window, click the New button. This launches 
the Psion Synchronizer Wizard, which takes you through the steps 
required to set up the synchronization. If you have never created a syn-
chronization before, PsiWin bypasses this window and goes straight to 
the Synchronization Wizard.
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4. The welcome screen of the Wizard asks you which PC PIM you want to 
synchronize with. Highlight the relevant option and click the 
Next button.

5. In the Psion section of the Applications dialogue, specify the netpad 
files you want to synchronize with. 

• To synchronize an Agenda 
file, make sure that the 
Synchronize My Agenda 
box is checked off. You 
will then need to specify 
the Agenda file to be syn-
chronized. You can either 
type in the path and file 
name you noted earlier, or 
click the  button and 
browse the netpad’s disks. 
If in doubt, use the Browse 
button to find your file.

• To synchronize a Data file 
or the Contacts program, 
make sure that the Syn-
chronize My Contacts 
box is checked off.

6. In the Choose contracts program dialogue:

• To synchronize with the Contacts program, leave the next box as Con-
tacts program. 
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• To synchronize with a Data 
file, click the  button. 
Next, select Data and specify 
the Data file to be synchro-
nized. 

You can either type in the path 
and file name you noted earlier 
or click the  button to 
browse the netpad’s disk(s). If 
in doubt, use the Browse button to find your file. Next, click the OK 
button.

7. Specify which Schedule+ Appointment book to synchronize and which 
Exchange profile to synchronize with. Normally, you should leave this 
as the default setting, but contact your Network Administrator if you 
have any doubts.

Important: Note that it is very important that this information is entered cor-
rectly – if it is not, the wrong files may be synchronized, or no syn-
chronization will occur. However, if you do not have an existing 
Agenda or Database file on your netpad, the synchronizer can 
create them. This is especially useful for a Contacts database - if 
you specify a non-existent netpad Datafile, the synchronizer will 
create a new one on the netpad that is optimized for use with your 
Schedule+ contacts. The synchronization can only create a Data 
file if you have selected the option to synchronize a Data file.
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8. Click the Next button.

9. Specify which types of 
entry you wish to syn-
chronize. Uncheck par-
ticular entry types if 
you do not want them to 
be synchronized. 

10. Click the Next button.

11. To specify the period 
of entries you wish to 
synchronize, click the 
Set date range 
button, select the 
period required and 
click the OK button.

To specify how the 
synchronization will 
deal with entries 
outside of normal 
working hours, select 
the appropriate option 
from the Agenda 
entries to synchronize 
section. You can also 
change your work 
hours by clicking the 
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Set work hours button, altering the settings as appropriate and clicking 
the OK button.

Next, click on the Advanced button to set up the label mapping. 

Note: If you are synchronizing with the Contacts, or have chosen not to synchro-
nize a Data file, you may not be able to click this button. In this case, you 
should ignore step 12 and click the Next button.

12. The Contacts Synchro-
nization dialogue 
shows a table, listing 
the labels for the Con-
tacts section in Sched-
ule+ in the Contact 
information column, 
and in the Psion label 
column you can match 
these to their equiva-
lents (if any) in your 
netpad Data file. To 
match labels:

• Find the Schedule+ 
label whose func-
tion is the same as 
one of your netpad 
Data file’s labels, 
then click in the box 
next to it in the Psion label column.

• Click on the arrow  to the right of this box. A drop-down list 
appears containing all the Psion labels that you have not matched. Select 
the label you wish to assign.

• If you do not wish to synchronize a particular Schedule+ Contacts label, 
select <Ignore> from the drop-down list.

Note: Each netpad label can only be matched to one Schedule+ label.
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13. When you have finished matching the labels, click the OK button and 
then the Next button.

14. To start the synchronization process immediately, click on the Syn-
chronize Now button, otherwise click on the Finish button to complete 
the set-up and save the synchronization.

If this is the first time you have run the synchronization, you may see 
the Contacts Synchronization dialogue described above. If there are any 
labels on the netpad that cannot be directly mapped, the synchroniza-
tion prompts you to do this manually.
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7.7.3.4 Multiple Synchronizations
It is possible to synchronize more 
than one Agenda and Data files with 
multiple Schedule+ files. When you 
create the synchronization, enter the 
appropriate paths and file names in 
the Applications dialogue.

7.7.4  Synchronizing Your netpad With Lotus Organizer
This section details the set-up and day-to-day use of PsiWin 2.3 to synchronize your 
netpad’s Agenda and data files, or Contacts program, with Lotus Organizer on 
the PC. The section assumes some basic familiarity with the use of Windows 
95/98/NT 4.0.

7.7.4.1 Software Compatibility
The details for this section assume that you are using PsiWin version 2.3. To check 
which version of PsiWin you have, double-click the My Psion icon on your desk-
top, and select About PsiWin 2.x from the Help menu. If you have at least Build 
136, you have version 2.3. 

You must also have a full installation of Lotus Organizer. While this section talks 
about Lotus Organizer 97 GS (PIM-only installation), the synchronization set-up 
procedure is identical for Lotus Organizer 2.1 or 97. If you are using Organizer 97 
GS as a PIM with Group Scheduling, then see page 118. 

Note: You cannot synchronize with Lotus Organizer version 2.0 or 2.01.
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7.7.4.2 Creating New Synchronizations
You can create multiple synchronizations on your PC if you have different Agenda 
or Data files that you want to synchronize. See “Multiple Synchronizations” on page 
110. You will need to define at least one synchronization.

Required Information
Before creating the synchronization, you will need to note the locations of the files 
you wish to synchronize: the synchronization must be told which files you wish to 
use. You must also tell the synchronization the location of your Lotus Organizer file.

1. Open the file(s) that you wish to synchronize. 
• Tap the file name at the top of the toolbar.

The Open files / programs dialogue is displayed. 
• Scroll through the list until you find your file(s) listed. Make a note of 

the path (in this example, c:\Documents\Agenda). 

2. On the PC, click on the Start button and select Find then Files or folders. 

3. In the Named box type in:
• *.or2 if you have Organizer 2.1, 
• *.or3 if you have Organizer 97, or 
• *.or4 if you have Organizer 97 GS (PIM only).

Make sure that the program is looking in the drive where you keep your 
Organizer file(s), and that the Include subfolders box is checked off.
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4. Click the Find Now button.

You should now have a list of Organizer files. If you double-click on 
the vertical line to the right of In folder, it will expand the view to 
include the whole path of the file. In the example above, the path and 
file name of the first file in the list would be C:\lotus\orga-
nize\chris.or4.

Note: If you have not previously created an Organizer file, this list will be 
empty. To create an Organizer file, open Lotus Organizer. Select Save as 
from the File menu. Give the file a name and click the Save button. Then 
return to step 2.

7.7.4.3 Creating The Synchronization
1.Make sure that your netpad is connected to the PC, and 
then double-click on the My Psion icon. Assuming the 
machines have linked successfully, you will see several 
icons, including one labelled Psion Synchronizer. 
Double-click on this icon.

2. In the Psion Synchronizer window, click the New button. This launches 
the Psion Synchronizer Wizard, which takes you through the steps 
required to set up the synchronization. If you have never created a syn-
chronization before, PsiWin will bypass this window and go straight to 
the Synchronization Wizard.
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3. The welcome screen of 
the Wizard asks you 
which PC PIM you want 
to synchronize with. 
Highlight the relevant 
option and click the 
Next button.

4. In the Applications dia-
logue, enter the path for 
the Agenda, Data and 
Organizer files you want 
to synchronize.

In the Psion section, 
specify the netpad 
files you want to 
synchronize with.

To synchronize an 
Agenda file, ensure that 
the Synchronize My 
Agenda box is checked 
off. Specify the Agenda 
file to be synchronized. 
You can either type in the 
path and file name you 
noted earlier or click the  button to browse the netpad’s disk(s). If 
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in doubt, use the Browse button to find your file. 

To synchronize a Data file or the Contacts program, make sure that the 
Synchronize My Contacts box is checked off. 

5. To synchronize with the Contacts program, leave the next box as 
Contacts program. 

• To synchronize with a Data file, 
click the  button. Next, 
select Data and specify the Data 
file to be synchronized. 

You can either type in the path 
and file name you noted earlier 
or click the  button to 
browse the netpad’s disk(s). If in 
doubt, use the Browse button to 
find your file. Next, click the OK button.

The Scheduling environment section of the dialogue can normally be 
ignored. However you will need to change this if your copy of Lotus 
Organizer has been specifically set up to connect with cc:Mail or Notes, 
or to work over a network. You should consult your Network Adminis-
trator if you believe this may be true in your case or, if you are using 
Organizer 97 GS as a PIM with Group Scheduling. See section 7.7.5 on 
page 118.

6. Specify your Lotus Organizer file. You may either type in the file name 
(including its directory) or click the  button to browse for the file 
(in this example, c:\lotus\organize\chris.or4).

7. Click on the Next button.
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Important: It is very important that this information is entered correctly – if it 
is not, the wrong files may be synchronized, or no synchronization 
will occur. However, if you do not have an existing Agenda or Data-
base file on your netpad, the synchronizer can create them. This is 
especially useful for a Contacts database - if you specify a non-
existent Datafile, the synchronizer will create a new one on the 
netpad that is optimized for use with your Organizer contacts. The 
synchronization can only create a Data file if you have selected the 
option to synchronize a Data file.

8. The next dialogue allows 
you to specify which 
types of entry you wish 
to synchronize. Uncheck 
particular entry types if 
you do not want them to 
be synchronized.

Check in your Lotus 
Organizer file whether 
the Calendar, Anniver-
sary, Planner or To-do 
sections have been 
renamed. If any of these 
names have been 
changed in your Orga-
nizer file, you will need 
to edit the names in this 
dialogue so that they 
match. 

If the Address section in Lotus Organizer has been renamed, you will 
also need to specify its new name in this dialogue.

9. Click the Next button.
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10. To specify the period of 
entries you wish to syn-
chronize, click the Set 
date range button. 
Then select the period 
required, and click the 
OK button.

To specify how the syn-
chronization will deal 
with entries outside of 
normal working hours, 
select the appropriate 
option from the Agenda 
entries to synchronize 
section. You can also 
change your work hours 
by clicking the Set 
work hours button, 
altering the settings as appropriate and clicking the OK button.

Next, click on the Advanced button to set up the label mapping. 
Note that if you are synchronizing with the Contacts program, or have 
chosen not to synchronize a Data file, you may not be able to click this 
button. In this case you should ignore step 11 below and click the 
Next button.

11. The Contacts Synchronization dialogue shows a table, listing the labels 
for Address in Organizer on the Contact information column, and on 
the right you can match these to their equivalents (if any) in your 
netpad Data file. To match labels:
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• Find the Organizer label 
whose function is the 
same as one of your 
netpad Data file’s labels, 
and then click in the box 
next to it in the Psion 
label column.

• An arrow  appears to 
the right of this box. If 
you click on this, a drop-
down list appears, con-
taining all the Psion 
labels that you have not 
matched. Select the label 
you wish to assign.

• If you do not wish to syn-
chronize with a particular 
Organizer Address label, 
select <Ignore> from the 
drop-down list.

Note: Each Psion label can only be matched to one Organizer label.

12. When you have finished matching the labels, click the OK button and 
then the Next button.
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13. To start the synchroni-
zation process immedi-
ately, click on the 
Synchronize Now 
button, otherwise click 
on the Finish button to 
complete the set-up and 
save the synchronization.

If this is the first time 
you have run the syn-
chronization, you may 
see the Contacts syn-
chronization dialogue 
described above. If 
there are any labels on 
the netpad that cannot 
be directly mapped, the 
synchronization will 
prompt you to do 
this manually.

7.7.5  Synchronizing With Organizer 97 GS 
(As A PIM With Group Scheduling)

When you use Organizer 97 GS as a PIM with Group scheduling, it uses your Lotus 
Notes Calendar and Address book. Because of this, the set up process for the syn-
chronization is slightly different.

1. Follow the steps in “Required Information” on page 111.

2. Follow steps 1, 2 and 3 in “Creating The Synchronization” on page 
112.

3. Enter the details of your Agenda and Data files or select the Contacts 
program as described in steps 4 and 5 of “Creating The Synchroniza-
tion” on page 112.
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4. In the Scheduling environment 
section, select Notes. 

5. Enter the Notes server on which 
your Calendar file is stored. 
However, if the file is on a local 
disk, leave this field blank. 

6. Enter the file name. If the file is 
on a local disk, this should be 
the full path to the file, in this 
example c:\notes\data\calen-
dar.nsf.

Note: If you do not have this informa-
tion, contact your Network 
Administrator.

7. Click the Account tab.

8. Enter your Notes user name and password. 

9. Click the Next button.

10. Follow steps 10 onwards in “Creating The Synchronization” on 
page 112.

7.7.5.1 Multiple Synchronizations
It is possible to create multiple synchronizations to synchronize more than one 
Agenda or Data file or more than one Organizer Address section. 

To do this, you may need to create extra Organizer sections: 

1. Select Customize from the Section menu.

2. Click on the Add button. 



Chapter 7: Connecting netpad To A PC
Synchronizing With Organizer 97 GS

120 Psion Teklogix netpad EPOC User Manual

3. Select the type for the new section, type in a name, for example, Work 
Calendar, and click OK twice.

4. When you create the synchronization, 
enter the appropriate file paths 
and names. 

5. In the Entry types dialogue in step 10 
in “Creating The Synchronization” on 
page 112, put the name of the new 
Organizer section against the appro-
priate netpad section and uncheck the 
rest of the boxes. 

6. Click the Next button and carry on with the synchronization as 
described in the previous section.
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7.7.6  Using An Existing Synchronization
Once you have set up the synchronization as above, you can use it whenever you 
wish. To run an individual synchronization: 

1. Connect your netpad and PC.

2. Double-click on the My Psion icon, and then double-click on the Psion 
synchronizer icon.

3. Click on the icon for the desired synchronization(s) so that they are 
highlighted.

4. Click on the Synchronize button.
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8.1  Introduction
Before you can use the Internet and e-mail programs or the optional 802.11 radio or 
GSM/GPRS on your netpad, some basic configuration is necessary. 

For instructions on setting up the 802.11 radio, please refer to “802.11 Radio Con-
figuration”, below. For details on setting up the GSM/GPRS radio, please refer to 
“GSM/GPRS Modem Configuration” on page 129.

For instructions on using Opera (the Internet browser) and ‘Email’ (the e-mail, fax 
and SMS application), please refer to “Internet And E-Mail Settings” on page 134.

8.2  802.11 Radio Configuration
The following are the basic settings necessary to be able to run the netpad on an 
802.11 radio network.

1. From the Control Panel, select the Ethernet menu.

2. The If idle, stay connected for and On exit, stay connected for 
options can be changed by tapping the time box; the Psiboard will 
appear so the times can be changed to the user’s settings.
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3. The user can select which LAN device to use by cycling through the 
current Settings options. A new connection mode can be created by 
pressing New, an existing choice can be updated by pressing Edit, 
when the following menu appears. 

4. By selecting Device on the previous menu, the following three options 
are shown. Select Lucent WaveLAN / Orinoco Card.
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5. By selecting Device options on the previous menu, the following menu 
appears. Type the WaveLAN network name using the Psiboard 
keyboard. (The network name will be provided by the 802.11 network 
administrator).

6. By selecting the Advanced tab on the above screen, the following menu 
appears. Select the Transmit rate from the four options. (The 802.11 
network administrator can provide the correct transmission rate). On 
completion of selection press OK to exit the menu.
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7. Press Done to exit. The following menu will appear. To complete the 
802.11 configuration, press OK. 

The netpad is now setup to run on an 802.11 network. To logon to an 
802.11 network, the user will require a software application such as 
Opera or Tekterm.

8. The netpad will return to the Control Panel screen.

8.3  802.11 Signal Strength Indicator
The 802.11 signal strength is shown above the time or date icon. Four bars indicate 
maximum strength. If the signal is lost, the antenna icon has a red cross over it.

Signal Strength Indicator
with Antenna Icon
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8.4  GSM/GPRS Modem Configuration
The following menus provide the configuration settings for the GSM/GPRS radio 
card. For details on setting up a modem through the serial port, please refer to “Con-
necting The Modem (Serial)” on page 140.

1. From the Control Panel, select the Radio Status icon.

2. The following General information screen appears, showing the radio 
parameters.

Signal Quality displays one of the following values when connected to 
a radio network:

No Signal
Weak
Average
Good
Excellent
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GPRS Available displays Yes or No. You can also tell from the front 
screen if you are attached to the GPRS network by the G icon above 
the clock.

Pin Required displays Yes or No.

IMEI number (International Mobile Equipment Identity) displays the 
IMEI number programmed into the radio card.

Serial Number displays the serial number of the radio card.

3. By tapping on Information the following radio card parameters appear.

Firmware Rev displays the firmware revision of the Option card.

SIM IMSI displays the International Mobile Subscriber Identity 
number from the SIM fitted into the netpad.

Current Band displays the current frequency band selected in the 
radio card. The frequency band can be changed using the Settings screen 
(for instructions and the list of available frequency bands, see page 131).
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4. Select the Settings screen to change the frequency band. This screen 
displays the selected frequency band.

5. Changing the frequency band.

You can change the frequency band by double tapping the displayed 
band, and five options will be shown in a drop-down list. Highlight the 
required frequency, then tap the Commit button to change the fre-
quency. Tap the Done button when the correct frequency has been 
selected.

The frequency band options that can be selected in the radio card are:
Single EGSM Band (900Mhz only)
Single DCS Band (1800Mhz only)
Single PCS Band (1900Mhz only)
Dual EGSM & DCS Band (900Mhz & 1800Mhz)
Dual EGSM & PCS Band (900Mhz & 1900Mhz)
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8.5  GPRS Connection/Signal Strength Indicator
The system screen displays whether there is a GPRS connection and the strength of 
the signal to the radio network. This information is displayed in the system window 
above the Date/Clock icon.

If there is no GPRS connection, the G above the Date/Clock icon turns white in 
colour and may be invisible to the user.

If there is no signal to the radio network, the Antenna icon in the Date/Clock icon 
box has a red cross over it.
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When a connection to the radio network has been established, the radio icons in the 
Date/Clock icon box will change to show the connection. 

If a GPRS connection is available, the G in the Date/Clock icon box will turn blue.

The signal strength indicator will display the strength of connection to the radio 
network in a maximum of four bars:

One Bar = Weak Signal Strength
Two Bars = Average Signal Strength
Three Bars = Good Signal Strength
Four Bars = Excellent Signal Strength
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8.6  Internet And E-Mail Settings
8.6.1  Overview
This section covers some general questions that people ask about using e-mail and 
the Internet, and provides a glossary of terms. The later sections list the information 
you will need to know before you start setting up the netpad, and then provide step-
by-step instructions.

8.6.1.1 Displaying Online Help
After you’ve set up your netpad, you can display online help about ‘Email’ and 
Opera on your netpad. In each program, select Help on … from the Tools menu.

8.6.1.2 Using The Internet On netpad
You can use your netpad to:

• Access the Internet and view web pages using the Opera program.

• View locally stored web pages and graphics files.

• Download files e.g. additional programs for your netpad.

8.6.1.3 Using E-mail On netpad
You can use your netpad to send and receive e-mail messages using either one, or 
both, of the following methods:

Connecting By Telephone Line To A Remote Mailbox
This is when you make a ‘live’ connection to your e-mail mailbox via a telephone 
line (without needing a PC). For example, you could access your personal mailbox 
by dialing your Internet Service Provider (ISP), or access your work mailbox by 
dialling your company's service provider or office mailbox.

What to do next…
If you want to access your work mailbox, you will first need to contact your 
network administrator to find out whether you can make a ‘remote’ (dial-up) con-
nection to your mailbox. See “Types Of E-mail Account” on page 135 to con-
tinue.
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Connecting A PC To Access Your Mailbox
This is when you connect directly to a PC that can access your mailbox. Using Psi-
Win's ‘Email Synchronization’, you can write e-mails offline on your netpad, and 
then connect to your PC to send and receive messages.

How do I do this?
To access your mailbox via a PC, you will first need to install PsiWin on the PC 
and set up ‘Email Synchronization’. This manual does not include information 
on ‘Email Synchronization’. If you wish to use ‘Email Synchronization’, see the 
PsiWin CD ROM.

8.6.1.4 Types Of E-mail Account
There are a number of different types of e-mail account. See the list below to find 
out which types of account you can connect to using the e-mail program on 
your netpad.

Personal Dial-up Account
This could be a dial-up e-mail account which you’ve signed-up for with an Internet 
Service Provider (ISP).

Which ISPs can I use?
You can use most ISPs which use ‘Internet standard’ methods for connecting to 
your e-mail account. However, some ISPs (such as America Online) use propri-
etary methods for connecting, and cannot be accessed by your netpad (i.e. you 
must use a PC). Move on to ‘Setting up your netpad’ to continue.

Remote (e.g. Office) E-mail Account
This could be an e-mail account at your workplace, e.g. using Lotus cc:Mail or 
Microsoft Mail.

How do I find out if I can use my account?
You will need to find out from your network administrator whether you can 
access your e-mail mailbox using this type of account. If you can, move on to 
‘Setting up your netpad’ to continue.
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Web-based E-mail Account
This is an e-mail account that you must connect to using a Web browser, e.g. 
HotMail or Yahoo! Mail.

Note: You can’t connect to this type of account using the e-mail program.

To use web-based e-mail, you must first set up your netpad for Internet 
access. You will need to use the Opera program to access your e-mail pro-
vider’s Web site.

8.6.1.5 If You Don’t Have An Internet/E-mail Account
You will require an e-mail account before you can access the Internet and send and 
receive e-mail messages on your netpad.

• To get a personal e-mail account, you must ‘sign-up’ with an Internet 
Service Provider (ISP). ISPs usually provide an e-mail account as part of an 
Internet access package.

• Most ISPs will provide software (e.g. a CD-ROM) which will help you set 
up Internet access and the e-mail account on a PC.

Important: Some ISPs require that you connect to them using a PC in order to 
sign-up. If you can’t do this, contact the ISP to find out if you can 
sign-up without using a PC. 
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8.6.1.6 Glossary Of Terms 
DNS

The Domain Name System is an address book, which allows computers on the 
Internet to find each other by using ‘IP addresses’ and ‘Hostnames’.

E-mail
An e-mail (electronic mail) is a text message that is sent over the Internet.

Hostname
A human readable version of an IP address, e.g. www.psionteklogix.com could 
be the same as the IP address 194.129.243.153.

IP address
A computer’s unique Internet address, e.g. 194.129.243.153, used by computers 
to communicate with each other.

ISP
Internet Service Providers are companies that provide you with access to the 
Internet. An ISP ‘account’ normally includes the facility to send and receive e-
mail using a personal e-mail address.

POP3/IMAP4
Internet ‘protocols’ (standards) for receiving e-mail.

SMTP
An Internet protocol used for sending e-mail.

TCP/IP
An Internet protocol used by computers to communicate with each other.

8.6.2  Setting Up Your netpad 
8.6.2.1 How To Use Opera/Email
To access the Internet and send and receive e-mail on your netpad you must have 
the following:

1. An appropriate e-mail account.
To access the Internet and use e-mail, you will need an Internet ‘stan-
dard’ e-mail account. 
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2. A Modem.
You will need a modem to connect your netpad to the telephone net-
work. You can use the following types of modem with your netpad:

• Standard external PC modems.
• Internal radio modem (GSM variant), see “GSM/GPRS Modem Config-

uration” on page 129 for details.

• Infrared-enabled mobile phones with built-in modems.

3. A telephone connection.
If you are using a standard external modem, you will need to connect 
your modem to a telephone socket. If you are using a mobile phone, 
your network operator will need to enable your SIM (Subscriber Iden-
tity Module) card so that you can make fax and data calls on your 
phone. If your phone has been enabled for fax and data calls, you 
should have two extra phone numbers. Contact your network operator 
if you are unsure whether your phone's SIM card is ‘data-enabled’.

8.6.2.2 Getting Help
If you are having connection problems, you can find information about connecting 
using specific service providers, modems or mobile phones on our Web site at 
www.psion.com/mobile.

8.6.2.3 What Information Do I Need? 
Before you can set up your netpad, you will need to find out some information about 
your modem and your Internet e-mail account by:

• Checking any documentation your ISP supplied about your Internet 
account, or contacting your network administrator at work.

• Checking your ISP’s Web site for technical support.

• Contacting your ISP by e-mail or phone for technical support.

• Checking the Psion Teklogix Web site at www.psion.com/mobile for 
details of worldwide ISPs and to use the ISP configuration wizard.

Note: The PsiWin CD-ROM contains ‘templates’ for popular Internet Service 
Providers, including those in the UK, US and Germany. You can use these 
templates to help you set up your e-mail account quickly.
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Information Checklist 
The checklist in Table 8.1 shows what information you will need to set up your 
netpad. Only your ISP or your network administrator can supply all the information 
required about your Internet e-mail account.

Information You Need Where To Find It Write It Here

Speed at which you should 
use your modem (called the 
baud rate).

Your modem’s documentation.

Phone Number you need 
to dial to connect to your 
ISP (often called a Point of 
Presence or POP).

From your ISP/administrator.

Username for your Inter-
net account.

From your ISP/administrator, 
e.g. “jrook” or “nd44”.

Password for your Inter-
net account.

From your ISP/administrator, 
or you may have chosen this 
yourself.

POP3 or IMAP4 server 
address (for incoming mes-
sages).

From your ISP/administrator 
e.g. “pop3.myisp.com”.

SMTP server address (for 
outgoing messages).

From your ISP/administrator 
e.g. “smtp.myisp.com”.

E-mail Address (your per-
sonal address).

From your ISP/administrator 
e.g. “myname@myisp.coml”.

Table 8.1 Information Checklist
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Some service providers require additional information to ‘log on’ to their server. 
You may need the following information when using some service providers.

8.6.3  Setting Up E-mail On netpad 
If you have collected all the information in the checklist, you are now ready to set up 
your netpad to connect to your ISP.

8.6.3.1 Connecting The Modem (Serial)
1. If you are not using a radio for communications, connect your netpad to 

the modem using the netpad’s serial cable. (For GPRS radio modem 
settings, refer to page 129.)

What Do I Need To Do This?
To connect your netpad serial cable to your modem you may require a Psion 
Teklogix modem cable adaptor. You can only use a Psion Teklogix adaptor, 
which can be obtained from your local distributor.

2. Connect your modem to the telephone socket and switch on 
the modem.

Optional Information Where To Find It Write It Here

IP Address (if your ISP’s 
server doesn’t provide one 
automatically).

From your ISP/administrator 
e.g. “194.129.243.153”.

DNS Addresses (primary and 
secondary DNS addresses if 
your ISP’s server doesn’t 
provide them automatically).

From your ISP/administrator 
e.g. “123.255.78.90” and 
“123.255.78.92”.

Mailbox Login (if different 
from your Internet account 
username).

From your ISP/administrator.

Mailbox Password (if differ-
ent from your Internet account 
password).

From your ISP/administrator, 
or you may have chosen this 
yourself.

Table 8.2 ISP Additional Information
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8.6.3.2 Setting Up Dialling 
When you connect to the Internet, your netpad will need to dial your service pro-
vider’s telephone. You can set up different dialling ‘locations’ so that your netpad 
knows how to dial the number correctly, e.g. if you're dialling from the ‘office’ loca-
tion, you might need to add a ‘9’ before the number you want to dial.

To set a dialling location:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Dialling icon  to display the dialling settings.

3. Tap on the Current location line, and select the location you’re dial-
ling from:

• Select Home if you can dial without needing a prefix number.

• Select Mobile if you’re using a mobile phone.

• Select Office if you need to use a prefix (‘dial-out’) number before dial-
ling, e.g. ‘9’.

Location Options
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If you don’t want to use any of these pre-defined locations, you can add a new loca-
tion by tapping the New button and entering the appropriate details.

4. Tap on Edit and check that the dialling settings are correct for your 
location (this is not necessary for the ‘Mobile’ location), e.g. you may 
need to change the Area code.

5. Tap OK when you have finished setting up your dialing location.

8.6.3.3 Setting Up The Modem 
To specify the type of modem you are using:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Modems icon  to display the modem settings.

3. Tap on the Current modem line, and select the modem you’re using:

4. Select Generic modem settings if your type of modem isn’t shown. If 
the generic settings don’t work for your modem, tap New to add a new 
entry for your modem. See the documentation supplied with your 
modem for the required settings.

Settings For Chosen Location
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5. Tap OK when you have finished setting up your modem.

8.6.3.4 Setting Up Internet Service 
After you have set up your dialling location and modem, you need to create a new 
‘Internet service’ and enter your Internet account settings for your service provider. 
See “What Information Do I Need?” on page 138 for more details on the 
information required.

To set up your Internet service:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Internet icon  to display the Internet service settings.

3. Tap New to create a new Internet service (account).

4. On the Based upon line, select Standard settings, or if you have a 
‘template’ file containing your ISP settings, select Settings from file 
and choose the file.

Modem Options
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5. On the Service page, enter a name for your account and enter your 
service provider’s Standard dial-up number (or POP phone number).

6. On the Account page, remove the checkmark from Manual login and 
enter the Username and Password for your Internet account.

Enter a valid access phone numberEnter a name for your new account

Enter your username and passwordUncheck this option
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7. If your service provider requires you to specify IP and DNS addresses, 
you can set these on the Addresses page. Before you can enter IP and 
DNS addresses, you must first remove the checks from the Get IP 
address from Server and Get DNS address from server boxes.

8. When you have finished entering the settings, tap Done to return to the 
Internet service settings dialogue. The new service you’ve created will 
be shown on the Current Internet service line. Tap OK to return to the 
Control Panel.

Note: What if I need to use a ‘login script’?

Some Internet Service Providers require that you use a login script when 
you connect, e.g. to send details such as your username and password. You 
can type in a login script on the Login page of your Internet service set-
tings. See the ‘Email’ document for more information on writing login 
scripts.

Either checkmark the box or Either checkmark the box or
enter a valid IP address enter valid DNS addresses
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8.6.3.5 Setting Up The E-mail Program 
Once you have set up your Internet service, you can set up your e-mail account in 
the e-mail program.

To create a new account in e-mail:

1. Tap on the Email program icon .

2. Select Email from the Add new account command on the Tools menu.

3. On the Account page:

• Enter a name for your account (this can be anything you want).

• Enter your name as you want it to appear on all e-mails you send on the 
Your name line.

• Enter your e-mail address, e.g. “my.name@myisp.com”.

• If the Mailbox type line is displayed, choose the mailbox type, 
e.g. ‘POP3’ or ‘IMAP4’.

Either a name for the account
Enter a name that you wish
to appear on messages

Enter your e-mail address
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4. On the Outgoing page:

• Enter your outgoing mail (SMTP) server address, e.g. 
“smtp.myisp.com”.

5. On the Incoming page:

• Enter your incoming mail (POP3 or IMAP4) server address, 
e.g. “pop3.myisp.com”.

• Enter your Mailbox login (or username) and Mailbox password 
(these may be the same as your Internet username and password).

6. Tap OK when you’ve finished entering your e-mail account settings.

You are now ready to use your Opera and e-mail applications.

Enter your outgoing mail server address

Either your incoming mail server Enter your mailbox
address (POP3 or IMAP4) username and password
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Chapter 9: Printing With netpad
Introduction

9.1  Introduction
You can print from most of the programs on the netpad, including Data, Agenda, 
Word, Contacts, Sheet, Sketch and Program.

To print, you need one of the following:

• A printer, which is IrDA (Infrared) compatible, if you wish to print files 
using Infrared.

• PsiWin installed on your PC, if you wish to print files via a PC.

• A Serial Printer Link to connect to a serial printer.

Before you start printing, you need to specify:

• The method by which you are going to print.

• The “printer driver” for the printer you wish to use.

9.2  Setting Up The Printer 
You can select the standard printer you normally use to print out files on the netpad 
from the System screen. The printer you select in the System screen is used for all 
programs unless you select a different printer from within a program, to use for that 
program only.

To select the standard printer: 
tap Control Panel on the Toolbar, or select the Control Panel command from the 
Tools menu. Select the Printer icon, and select the printer model in the Print to 
line.
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To select a different printer to use for an individual program: 
open the program for which you want to change from the standard printer. 
Select the Print setup command from the Printing commands on the File
menu, and press the Printer button to change the printer model and/or port.

9.2.1  Printing Using Infrared 
You can print directly from the netpad to any Infrared capable (IrDA) printer. 

To set up for Infrared printing:

1. Select the Printer icon from the Control Panel in the System screen, or 
the Print setup command from the Printing commands on the File
menu.

2. If necessary, press the Printer button. Select the printer model in the 
Print to line and select Infrared as the method via which you want 
to print.

3. If you want, check the layout of the document using Print preview, then 
select the Print command from the Printing commands on the 
File menu.

4. Enter the range of pages and number of copies.

5. Point the netpad at the printer, making sure that the netpad and printer 
are no more than one metre apart, and press Print.
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9.2.2  Printing To A Serial Printer 
You can print to a serial printer a Serial Printer Converter to connect to the printer. 
To set up your netpad to print via a serial printer:

1. Select the Printer icon from the Control Panel in the System screen, or 
the Print setup command from the Printing commands on the File
menu in the program that you want to print from.

2. If necessary, press the Printer button. Select the printer model in the 
Print to line and select Serial port as the method via which you want 
to print.

You can change the settings for the serial port and handshaking by pressing the Set-
tings button.

9.2.3  Using PsiWin To Print Via A PC 
You can use PsiWin to connect your netpad to a PC. You can then print files from 
your netpad to almost any of the printers installed in Windows on your PC, whether 
directly connected, or networked to your PC.

1. Select the Printer icon from the Control Panel in the System screen, or 
the Print setup command from the Printing commands on the File
menu in the program from which you want to print.

2. If you are printing from within a program, press the Printer button.

3. Select Printer via PC in the Print to line.

You can now print a file using PsiWin to print via a PC. Refer to the PsiWin online 
help for more information.

9.2.4  Printing To A File 
You can use the netpad to print a document to a file. To set up your netpad to print to 
a file:

1. Select the Printer icon from the Control Panel in the System screen, or 
the Print setup command from Printing commands on the File menu, in 
the program from which you want to print.
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2. If necessary, press the Printer button. Select the printer model in the 
Print to line and select File as the method via which you want to print.

3. Press the Settings button to specify the name of the file, and the folder 
and disk to which you want to print. Press OK to redisplay the Printer 
setup dialogue.

When you print the file, it will be saved in the file you specified in the Print to file 
dialogue.

Important: Ensure that you use the correct file name, folder and disk drive. If a 
file of the same name already exists, it will be deleted and replaced 
with the new file that you are printing.

9.3  Selecting The Printer Model 
You can choose to print to various printer models. 

To select a printer:

1. Select the Printer icon from the Control Panel in the System screen, or 
the Print setup command from the Print button or the Printing com-
mands on the File menu, in one of the programs from which you 
can print.

2. If necessary, press the Printer button. Select the printer to which you 
want to print in the Print to line.

3. If required, change the method via which you want to print.

Note: When printing via a PC, you can only change the printer model on the 
PC. Refer to the PsiWin online help for more information.
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9.4  Page Setup 
You can change the size of the page and specify other layout settings by selecting 
the Page setup command from the Print button or Printing commands on the 
File menu:

• Select the size of the page on which you want to print (e.g. A4) and the page 
orientation. If the page size you require is not in the list of sizes, select 
Custom, and then type in the width and height of the page you want.

• Use the Margins page to change the distance between the edge of the paper 
and the text.

• Use the Header and Footer pages of the dialogue to enter the text that you'd 
like printed at the top and bottom of each page. You can format the header 
and footer text, and insert other information in it, including page numbers 
and the date.

• Use the Other page to specify where you want page numbering to begin in 
the document, and from which page you want to display the headers and 
footers.

9.5  Previewing A Document 
You can see how the document will look when printed by selecting the Print 
preview command from the Print button or the Printing commands on the 
File menu.

To select the page you want to preview, press the Go to button and enter the number 
of the page you want to view.

You can change the setup of the printed page and preview from the Print preview 
dialogue by pressing the Setup button to display a list of options:

• To change the layout of the page, select Setup.

• To specify the number of pages shown in the preview and whether you want 
to view the margins, select Preview.
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• To change the printer model and method, select Printer.

9.6  Printing A Document 
You can print out all or part of a document from the Contacts, Data, Agenda, Word, 
Sheet, Sketch and Program editor programs.

To do this:

1. Tap the Print button or select the command from the Printing com-
mands on the File menu.

2. In the dialogue you need to specify how many copies of the selected 
pages you want to print.

3. (In Word you can also change the range of pages to print in a multi-
page document. If you don’t change the range, one copy of the whole 
document will be printed.)

4. Press OK to start printing the document.
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Chapter 10: netpad Accessories
Introduction

10.1  Introduction
The following optional accessories are available from Psion Teklogix. These acces-
sories are compatible with all netpad models in the netpad product range. Please 
check the Psion Teklogix web site at www.psionteklogix.com for updates to this list.

10.2  Accessory Product List

ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

DOCKING STATION ITEMS
Docking Station Product Packs
The Desktop Docking Station provides charging and 
simultaneous data communications via the RS232. See 
Chapter 3: “netpad Docking Station” for details.
All Docking Station packs are supplied with a Power 
Supply Unit, RS232 Serial Cable & AC Power Leads 
for the following regions:
• UK and Europe 1201 0039 0002
• Australia, New Zealand & Japan 1201 0040 0002
• North America 1201 0044 0002

netpad Docking Station 
This item is offered as a replacement for a lost or 
damaged dEsktop Docking Station. It does not include 
the PSU or leads.

1201 0041 0001

Universal PSU for Docking Station
This item is offered as a replacement for lost or 
damaged PSUs. It does not include the mains lead.

A2032 0047 0002

In-vehicle Docking Station
The In-vehicle Docking Station provides a secure 
method for mounting and powering the netpad in vehi-
cles from 12VDC. See page 162 for details.

1201 0050 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

BATTERIES AND CHARGERS
875 mAh Li Ion Standard Battery A2202 0002 0002

1400 mAh Li Ion Enhanced Battery A2202 0001 0002

netpad Portable Battery Charger
The Portable Battery Charger provides a convenient 
method of charging a single battery pack from mains or 
12VDC vehicle power.

NP3001

netpad 4-Bay Battery Charger
The 4-Bay Battery Charger provides a convenient 
method of charging a up 4 battery packs from 
AC power.

NP3004

CARRYING CASES
There are a range of carrying cases that offer methods of carrying and protecting the 
netpad. The carrying cases are available in the following configurations.
Soft Carrying Case (for netpad 1100) c/w shoulder 
strap.

1202 0020 0001

Soft Belt Holster* (suitable for all netpads) c/w shoul-
der strap.
*See “Use Of The Soft Belt Holster” on page 19.

1202 0023 0001

Soft Carrying Case (for netpad 1200) c/w shoulder 
strap.

1202 0026 0001

Soft Carrying Case (for netpad 3500) c/w shoulder 
strap.

1202 0025 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

CABLES
RS 232 Serial Cable (9-pin Female D-type to netpad) A2203 0003 0002

RS 232 Adapter Cable
The RS232 Adapter Cable has 9-pin Male D-type for 
connection to the netpad R232 port and can be used to 
connect serial peripherals such as printers, modems or 
cell phones to the netpad

A2888 0015 0003

Replacement Power Leads are available for the fol-
lowing countries:
• USA power lead A2032 0036 0001
• UK power lead A2032 0037 0001
• Euro power lead A2032 0038 0001
• Japan power lead A2032 0041 0001
• Australian/New Zealand power lead A2032 0042 0001

MISCELLANEOUS
Replacement Stylus (Pack of 10) 1208 0015 0001

MMC Card Reader (Parallel Port Interface) A2888 0016 0001

16 MB MMC Card A2202 0018 0001

netpad EPOC Developer’s CD
The netpad EPOC Developer’s CD contains all of the 
development tools for the netpad.
The latest versions of the files available on the Devel-
oper’s CD are available for download from the netpad 
Developer’s Resource web site at: 
http://partners.psionteklogix.com/netpad-pdk



Chapter 10: netpad Accessories
The In-vehicle Docking Station

162 Psion Teklogix netpad EPOC User Manual

10.3  The In-vehicle Docking Station
The netpad in-vehicle docking station provides a durable and flexible solution for 
mounting the netpad in vehicles. It offers the following features:

• Highly adjustable. 
The mounting arm can be adjusted to provide the ideal viewing angle, no 
tools required. 

• Small footprint.
It requires less than a 62 mm x 62 mm (2.5 in. x 2.5 in.) mounting area.

• Securely mounted to a range of surfaces.

• Supports landscape or portrait orientation.

• One-handed release mechanism.

• Charging and Data communications. 

• One RS232 port.
For connection to peripherals such as printers, GPS receivers, radio 
modems or cell phones.

• Compact 12 VDC power supply.
With cigarette-lighter adaptor (which can 
be removed for permanent connection to 
vehicle power).
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Chapter 11: Troubleshooting netpad/PsiWin
General Troubleshooting Tips

11.1  General Troubleshooting Tips
You should read this chapter if you have any questions or experience problems 
using your netpad.

11.1.1  If An Alarm Doesn’t Ring 
If the alarm sounds are like beeps, your battery is too low to play the alarm sound 
you have chosen.

It may also be that the Sound is off so that the alarm screen is displayed but the 
sound is inaudible. The alarm screen will indicate if the sound is off or silenced for a 
particular period. Use the Sound icon from the Control Panel in the System screen to 
switch the sound back on again.

If an alarm is due to ring while you are recording another sound, the alarm will be 
postponed until you have finished your recording.

11.1.2  World Times Aren’t Correct In The Time Program
This is likely to be because of “daylight saving” or “summer time” settings (where 
clocks are put forward for the summer months).

The dates that clocks are set to change vary from country to country, and sometimes 
even within a country; some countries do not use summer times at all. Therefore, the 
netpad clock will not change automatically on the date that the clocks change. You 
will need to make sure that each zone is set to use its “summer time” setting when 
the clocks change in those countries. See the ‘Time User Guide’ document for more 
details.
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11.1.3  A File Appears To Have “Vanished”
When you tap on a program icon, the netpad will open the program with the file that 
you last used. If you only use one Agenda file, for example, this will always be dis-
played when you tap the Agenda icon.

However, if you move or rename your file, the netpad will not be able to find this 
“last used” file when you tap the program icon. So, it looks for a file with a standard 
filename (e.g. Word, Agenda, Sheet etc.) and displays this file instead. If there is no 
file with this name in the standard folder, a new file is created. 

You can re-open the original file from its new location using the Open file command 
on the File menu.

11.1.4  If You Forget Your Password 
If you forget a password set for a Word or Sheet file, you will not be able to open 
the file again until you remember the correct password.
If you forget the passcode set for the whole machine (see “Setting A System 
Passcode” on page 54), you will not be able to use the netpad until you perform a 
“hard reset”. All the files on the Internal disk will be lost and cannot be retrieved.
See “How To Reset The netpad” on page 167 for more information.

11.1.5  The netpad Doesn’t Turn On/Off 
If the netpad doesn’t seem to turn on:

• Check the screen contrast to make sure it isn’t set too low.

• Recharge the main battery. If you continue to use the netpad when the main 
battery is low, it will eventually not have enough power and the netpad will 
switch off. You will not be able to switch it on again until you place the 
netpad in the docking station to recharge the battery or replace the main 
battery with another, charged one.

If the netpad doesn't seem to turn off:

• Check the automatic switch off time using the Switch on/ off icon from the 
Control Panel in the System screen.
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Note: If you use OPL, note that a running OPL program can prevent automatic 
switch off if it neither pauses nor waits for a keypress.

11.1.6  How To Reset The netpad 
If you find that you cannot exit a program normally, move to the System screen and 
select the List open files command from the File menu. Select the program from the 
list and press the Close file button.

If this does not work, or if your netpad appears to have “locked up”, you can always 
perform a “soft reset”. This should restart your netpad while preserving most of 
your information.

It is worth trying a soft reset if the keys on the netpad do not appear to respond, or if 
the netpad appears to switch on and you are sure that the batteries are good (espe-
cially if the contrast adjustment still appears to work), but the screen is otherwise 
blank.

To perform a soft reset: 
gently press the stylus onto the reset switch. This is located inside the Card Slot 
door cover to the side of the MMC slot.

Card Slot Door Latch

MMC Card

Reset
Button
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After a soft reset, any changes to open files (such as Word or Sheet files) will be lost. 
Your other files on the Internal disk will almost always be safe.

It is possible (although unlikely) that a program failure causes the reset to lose the 
information on the Internal disk; it could even prevent the reset from working at all. 
If this happens, you will have to perform a “hard reset”.

To perform a hard reset: 
1. Remove the netpad from the docking station.
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).
4. While continuing to hold down the On/Off button, press and release the 

Reset button. 
5. Release the On/Off button. 

Important: A hard reset resets the netpad completely, and all information on 
the Internal disk will be lost.

11.1.7  Can’t Place The netpad In The Docking Station 
If you are having difficulty putting the netpad in the docking station, you may be 
attempting to insert it upside down. Push the netpad into the docking station until 
you hear a click.
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11.1.8  The Command Icons Don’t Work 
If tapping a Command icon has no effect, then you may have moved the Psiboard 
behind the icons. Move it to the main area of the screen by dragging the title bar. 
Then try again.

11.1.9  The Keyboard Disappears 
If the soft keyboard, the Psiboard, disappears, you can set the Preferences to 
‘Always on top’. Then it will remain displayed even when you move from screen to 
screen. To do this, display the keyboard and tap the P icon in the top right-hand 
corner. Then select Always on top.

If you cannot see the keyboard, you may have minimized it. In 
this case, only a small portion of the title bar is displayed in the 
bottom left-hand corner of the screen (as shown here). Tap on 
the underline maximize symbol to open the Psiboard again. 

11.1.10  Using HyperTerminal To Locate A Connection Problem
HyperTerminal is a basic communications program that comes as part of Windows 
95/98/NT 4.0.

1. Before using HyperTerminal, right-click on the PsiWin Connection 
Server icon,  or , and select Close. 

2. Start HyperTerminal by clicking the Start button, selecting Programs, 
then Accessories, and then HyperTerminal. 

Note: This is slightly different in NT 4.0. With NT, click Start, then Programs, 
then Accessories, then HyperTerminal and finally, HyperTerminal again. 
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3. You should then see an icon named either Hypertrm or 
Hypertrm.exe. Double-click this icon.

4. If you then get a dialogue asking whether you would like to install a 
modem, click the No button.

5. In the Connection Description dialogue, type in a name for the 
HyperTerminal session, then click the OK button.
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6. In the Phone Number dialogue, click on the  button on the 
Connect using line and select the COM port that you have the PsiWin 
cable connected to. Then click the OK button.

7. In the next dialogue, click the  button on the Bits per second line 
and select the baud rate you have set on the netpad. In the same way, 
change Data bits to 8, Parity to None, Stop bits to 1 and Flow control 
to Xon/Xoff. Then click the OK button. 
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8. If you get an error message saying Unable 
to open COM x, then there is another 
device using the COM port and prevent-
ing PsiWin from using it. This could also 
be due to an incorrectly installed COM 
port. 

9. If you get a series of characters repeating across the screen at regular 
intervals, this means that a signal is coming through from the netpad. In 
this case, you should try re-installing PsiWin on the PC.

10. If you get just a flashing cursor in the corner of the screen, try a soft 
reset on the netpad. If you still get a flashing cursor after this, it means 
that you have either a faulty PsiWin cable or a faulty serial port on 
the netpad.

11.2  PsiWin 2.3 Connection Problems 
Using Windows95/98/NT 4.0

This section is a guide to troubleshooting connection problems between a netpad 
and a PC running Windows 95/98/NT 4.0 and PsiWin 2.3. It also presumes you have 
already gone through the online help documents that come with PsiWin 2.3 and still 
have no success in linking. A basic knowledge of using the netpad and Windows 
95/98/NT 4.0 is necessary. For information about using Windows 95/98/NT 4.0, 
check your Windows manual or contact the Windows 95/98/NT 4.0 helpline. 

11.2.1  Tips When Installing PsiWin 2.3
Close any other programs that are running. This includes virus checkers, uninstall-
ers, floating toolbars etc.

If you need to re-install PsiWin 2.3, make sure you uninstall the previous version first:

1. Click on the Start button and select Settings, then Control Panel. 
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2. Double click the Add/Remove Programs icon. Select PsiWin 2.3 in 
the list and then click the Add/Remove button. 

Important: You must re-start your PC before re-installing PsiWin 2.3 or you 
will experience problems.

3. See the ‘Installing and Setting Up PsiWin’ document for 
more details.

11.2.2  Basic Troubleshooting For Your netpad
1. Close down all applications (especially Comms because it blocks 

the port). 
To do this, go to the System screen and select Close files from the 
Close cascade on the File menu. When asked if you wish to “Close all 
files/programs?”, tap the Yes button.
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2. Check that the Remote link is switched ON at the netpad end of 
the link.
Go to the System screen and select Link to desktop from the Tools 
menu. Check that the link is set to Cable. Tap the OK button to confirm 
this setting.

3. Try lowering the baud rate. 
The baud rate is set in the Remote Link dialogue. Try 57600,19200 and 
9600 in turn. Remember that the lower baud rate will not take effect 
until you confirm it by tapping the OK button.

4. Reset the port. 
This is particularly useful if you have linked successfully in the past but 
the link is now failing. Go to the System screen and select Close files 
from the Close cascade on the File menu. Change the option to OFF 
and tap the OK button. Select Close files from the Close cascade on the 
File menu again and reset the link back to Cable. Then tap the 
OK button.

5. Perform a soft reset on the netpad. 

11.2.3  Basic Troubleshooting For Your PC
1. Close down any other open applications in Windows.

2. If you have a laptop: 

• Make sure you have no PC Cards (PCMCIA cards) plugged in. 

• Most laptops have power-saving features that disable the COM ports. 
Turn these power saving options OFF. 

• If your PC has an Infrared port, make sure it is disabled and your 
serial/COM ports are enabled. Psion Teklogix can support you with any 
of these issues. Check the laptop’s manual or contact the manufacturers 
support department to get these issues rectified.

3. The PsiWin Connection server icon is in the bottom right-hand corner 
of your PC Screen. When you are not connected, it is a straight line 

. When you have made a successful connection, it becomes a 
wiggly line .
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• Right-click the Connection server icon 
and choose Properties from the pop-up 
menu that appears.

• On the Connections page 
of the My Psion Properties 
dialogue, make sure that 
baud rate is set to 
Maximum attainable.

• It is possible for PsiWin 2.3 
to conflict with a modem 
or mouse. Symptoms are 
the mouse pointer intermit-
tently locking up or soft-
ware that uses the modem 
intermittently freezing. 
Uncheck the COM Ports 
that are used by 
other devices.

4. If you are using Windows NT 
4.0, check that you have at 
least Service Pack 3 installed. If necessary, install it or contact your 
Systems Administrator.

11.2.4  Device Conflicts
To check for device conflicts:

1. Click on the Start button, select Settings and then Control Panel. 

2. Double-click on the System icon.

3. On the Device manager page of the System properties dialogue, check 
for icons marked with a symbol.

Note: This symbol means that the marked device is conflicting with another 
device. If a modem or COM port is conflicting, this could be a cause of 
PsiWin not connecting. Contact the person or organization that supports 
your PC to resolve the conflict.
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4. There is no Device Manager in Windows NT 4.0. The closest is a list of 
IRQs, I/O ports and DMA channels. These are accessed by the Start 
button, selecting Programs, then Administrative Tools (Common), 
then Windows NT Diagnostics. Select the Resources page in the 
Windows NT Diagnostics dialogue box. If you do not have this option 
or you are in any doubt about it, you should contact your Systems 
Administrator.
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11.2.5  Fax/Modem On COM 1/2/3/4
If you have a Fax/Modem using COM Port 3 or 4, and PsiWin on COM 1 or 2 (or 
vice versa), you may have trouble when trying to connect with the netpad.

Because of the way a PC handles COM ports, COM1 and COM3 are ‘linked’, as are 
COM2 and COM4. Specifically, they share the same Interrupt Request (IRQ). 

In practice, this means that if you have a modem on COM3, it may conflict with the 
netpad on COM1 (and the same applies for COM4 and COM2). The solution is to 
try using PsiWin on a different port or to assign a different IRQ. 

You can check the COM port properties by following the steps above to get to the 
Device Manager page and double-clicking on the COM port.

Again, if you are in any doubt about whether you are able to do this safely, you 
should contact the person or organization that supports your PC.
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If you have an external modem and have unplugged it to use the Psion Teklogix 
serial cable on the same port, you will not get a connection. Windows 95/98/NT 4.0 
reserves this port for use with the modem and so you will have to use another port.

11.2.6  The Temp Folder
The PsiWin connection can be affected if you have not specified, or have incorrectly 
specified, your Temp folder. To specify this: 

1. Click Start and 
select Run. Type 
sysedit in the dia-
logue and click OK.

A screen with multiple windows is displayed.
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1.

2. Click on the AUTOEXEC.BAT title bar. 

3. Look in this window to see if it has a line that starts SET TEMP=. If 
this line exists, check that the folder that it points to exists and create 
the folder if not. 

If this line doesn’t exist, place the cursor on a new line and type SET 
TEMP=C:\TEMP.

Close the window and choose Yes when asked if you want to save the 
changes.

4. Create a folder on the root of your C drive and call it Temp.

5. Finally, restart your PC.
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11.3  Troubleshooting PsiWin 2.3 
Synchronization Problems

This section discusses various problems that may be encountered when synchroniz-
ing Agenda and Data files, or the Contacts program (with Microsoft Outlook 97/98, 
Microsoft Schedule+ 7.0/7.0a/7.5, or Lotus Organizer 2.1/97/97GS). 

Some familiarity with these applications, Windows 95/98/NT 4.0, and your netpad 
is assumed. You will also need a full installation of your PC PIM. 

Note: This section should be used in conjunction with the manual to setting up a 
synchronization for each application.

The majority of synchronization problems are caused by setting up a synchroniza-
tion incorrectly. Please make sure you have read the appropriate sections in 
Chapter 7: “Connecting netpad To A PC” first. These explain the correct way to set 
up a synchronization.

11.3.1  Basic Troubleshooting For Synchronization Problems
By far the most common cause of a synchronization failing, apart from the wrong 
files being chosen in the set up, is corruption or spurious entries in one of the files. 

To test whether this is the case, synchronize a new Agenda and/or Data file with a 
new Outlook profile, Schedule+ file or Organizer file. If this synchronization works 
then the problem is with one of the original files. 

A process of elimination, by synchronizing one file at a time with blank files, should 
highlight which file is at fault. If the synchronization with new files does not work, 
look through the list of common problems later in this manual to see if the particular 
problem is listed. If not, it is likely that either PsiWin or your PC PIM is not installed 
properly (for example, with Outlook 98 you will need a full installation for synchro-
nization to work). See the ‘Installing and Setting Up PsiWin’ document or contact 
the supplier or manufacturer of your PC PIM.
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11.3.2  Other Things To Try
1. Delete your netpad details in PsiWin.

When PsiWin 2.3 connects to a machine for the first time, it asks you to 
enter a name for that machine. This registers details about your netpad 
on your PC. Sometimes this information can become corrupt. 

• Click the Start button and select Programs, then PsiWin 2.3, and then 
Machine Manager. This displays a list of the currently registered 
machines. 

• Highlight your netpad and click Delete This Owner, or just click the 
Remove details of selected machine button. 

The next time you connect your netpad, you will be asked to give it a 
name. Type in a different name from the machine name you have
just deleted.

2. Make a new backup and recreate any synchronizations.

3. If this doesn’t solve the problem, try a Tidy/archive operation on your 
Agenda file or a Merging in operation on your Data file.

• To perform a Tidy/archive operation in Agenda, open the file, and select 
Tidy/archive on the More cascade from the File menu. Change the 
Tidied entries are line to Copied to new file. Select All entries on the 
Which entries line, and change the Range line to Whole agenda.
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Enter a file name (in this example, Test) and select a folder and disk to 
create the file in. Then tap the OK button or press Enter. This will 
extract all the information from your Agenda into a new file (in this 
example, Test). Note that this is not the same as copying the file.

• To perform a Merge in 
operation on a Data file, 
open the file and press 
Ctrl + N. Enter a name 
for the new file (in this 
example, Test), select the 
folder to create it in and 
press Enter. This will automatically launch the new file.

In this new file, press Shift + Ctrl + I. In the Merge in dialogue, change the 
Disk and Folder lines to the disk and folder on which your original Data 
file is kept, and select the file name on the Name line. Then press Enter.

4. Set up a new synchronization, or synchronizations, to use the newly 
created files.

5. If you still have no success, export your PC PIM’s file or folders as text 
and re-import them into a new file or new folders. For information on 
how to do this, see below for Microsoft Outlook, page 185 for 
Schedule+ 7.x, and page 188 for Lotus Organizer.
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6. Check your PC PIM for spurious entries. These include:

• Repeating entries with only one occurrence.
• Alarmed entries with a reminder set for before 1980.
• Entries with a carriage return at the end of the subject line.
• In Outlook, entries with a ‘crossed swords’ symbol. Double-click on the 

symbol to resolve the problem.

11.3.3  Exporting And Re-importing A PC PIM With Outlook
1. Create a new folder to receive the information that you are about to 

export. To do this:

• In Outlook, select Folder in the New cascade from the File menu. 

• Type in a name for this folder (in this example, Test), select which type 
of information this folder is going to contain (this should be the same as 
the folder you are exporting, in this example, Appointment Items), 
and select the top-level folder in the list of folders (in this example, 
Personal Folders). 

• Then click the OK button. The new folder appears in the folder view in 
Outlook (if you have this showing). 
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2. Select Import and Export from the File menu. 

3. Select Export to a file and click the Next button. 

4. Select the folder you wish to export (in this case, Calendar). And click 
the Next button.

5. Select Comma Separated Values (Windows) and click the
Next button.

6. Type in a name for the export file (in this example, Calendar.txt) and 
click the Next button. Then click the Finish button.

7. To import the file into a new folder, select Import and Export from 
the File menu.

8. Select Import from Schedule+ or another program or file and click 
the Next button.

9. Select Comma Separated Values (Windows) and click the 
Next button.
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10. Type in the name you gave the export file (in this example, Calen-
dar.txt) and click the Next button.

11. Select the folder that you created 
earlier (in this example, Test) and click 
the Next button. Then click the Finish 
button.

Set up a synchronization to use the 
new folder.

Note: It may also be necessary to set up a new Outlook profile and import the 
data into this. See page 190 for information about creating a new 
Outlook profile.

11.3.4  Exporting And Re-importing A PC PIM 
With Schedule+ 7.x

1. Create a new Schedule+ file. To do this:

• Select New from the File menu. 

• Type in a name for the new file, for example, Test. 

• Click the Save button. 

2. To export your data to a text file, open the original Schedule+ file, and 
select Text in the Export cascade from the File menu.
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3. Select the type of items you wish to export (in 
this example, Appointments), and click the 
Next button.

4. Select the date range you wish to export and 
click the Next button.

5. In the next two dialogs, accept the 
defaults by clicking the Next 
button twice.

6. Click the Add All button to export 
all the fields and then click the Next 
button.

7. Type in a name for the export file, or accept the default, and click the 
Finish button.

8. To import, first open the new Schedule file you created earlier by 
selecting Archive or Project Schedule in the Open cascade from the
File menu. 



Psion Teklogix netpad EPOC User Manual 187

Chapter 11: Troubleshooting netpad/PsiWin
Exporting And Re-importing A PC PIM With Schedule+ 7.x

9. In this file, select Text from the Import cascade from the File menu.

10. Type in the path and name of the export file. If you accepted the 
default when exporting, this will already be entered. Then click 
the Next button.

11. Accept the defaults in the next two dialogs by clicking the Next 
button twice.

12. Select the type of data in the export file (in this exam-
ple, Appointments), and then click the Next button.

13. On the final screen, map the fields between the two 
Schedule+ files. Opposite each field, to its right it 
says IGNORE THIS FIELD. Click on this and a 
down arrow  appears. Click on this and a list of 
field types appears. Select the type that corresponds to 
the field on the left. Do this for all the fields and click 
the Finish button.

14. Set up a new synchronization to use the new Schedule file.
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11.3.5  Exporting And Re-importing A PC PIM With Organizer
1. Create a new section to receive the information that you are about to 

export. To do this:
In Organizer, select Customize from the Section menu. 

2. Click the Add button.

3. On the Section type line, select 
the type of section you would 
like to add (in this example, 
Calendar), and type in the 
name you wish to use for this 
section (in this example, Test). 
Then click the OK button. 

The new section appears as a tab in the main view in Organizer.
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To Export A Section
1. Select Export from the File menu.

2. On the From section line, select the section that you wish to export (in 
this example, Calendar), 

3. Select ASCII Delimited Text on the Files of type line and type in a file 
name (in this example, Calendar.txt).

4. Click the Export button.

To Import The Information
1. Select Import from the File menu.
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2. On the Into section line, select the section you created earlier.

3. Select ASCII Delimited Text on the Files of type line, and select the 
file you exported to earlier (in this example, Calendar.txt). 

4. Click the Import button.

5. Set up a new synchronization to use the new section.
It may also be necessary to import the data into a new Organizer file. 

6. To create a new Organizer file, select New from the File menu, type in 
a name for the file and then click the OK button.

11.3.6  Creating A New Outlook Profile
Creating a new Outlook profile should only be attempted if you have a non-net-
worked copy of Outlook. If you use Outlook on a network that is running Exchange, 
contact your Network Administrator.

To create a new Outlook profile: 

1. Click the Start button; select Settings, then Control Panel. 

2. Double-click the Mail and Fax icon (Mail icon if you have Outlook 
98). 

3. In the Properties dialogue, click the Show profiles button. A list of all 
the Outlook profiles on the PC is shown. 

4. Click the Add button.

5. Select Manually configure information services and click the 
Next button.

6. Type in a profile name (in this example, Test) and click the Next button.

7. In the Properties dialogue, click the Add button to add an information 
service to the new profile.
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8. Highlight Personal Folders and click the OK button.

9. Type in a name for the Outlook file 
(in this example, Test.pst) and click 
the Open button.

10. Select No encryption and click the OK button.

11. Click the OK button again, and then the Finish button. Click the Close 
button to exit the Wizard.

12. Open Outlook, and select Options from the Tools menu.

13. On the General page, select Prompt for a profile to be used and click 
the OK button.

The next time you start Outlook, you will be asked which profile you 
wish to use.

11.3.7  Outlook: Failed To Open Outlook

This error message can appear just after the start of the synchronization process. 
There can be two reasons: 
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Your Outlook Profile Has Been Incorrectly Entered
To check this, first make sure you have your profile name: in Outlook, select 
Options from the Tools menu.

On the General page, if Always use this profile is selected, your profile name will be 
in the textbox next to it. If Prompt for a profile to be used is selected, your profile 
name is the one you select when you start up Outlook.

See “Synchronizing Your netpad With Microsoft Outlook” on page 93 to make sure 
that this information has been entered correctly in the synchronization properties.

The Path To The Outlook Folder(s) Being Synchronized Is Incorrect
To check the path to the folder, make sure you can see the Folder view in Outlook. 
(To show it, select Folder view from the View menu.)

In the example shown here, if you were trying to synchronize the Example folder, 
the path would be:

Program Files\Contacts\Example

If you have a top level folder that looks like 

Mailbox – [Chris Dickins] or
Outlook Today – [Chris Dickins]

then the path would be:

Chris Dickins\Contacts\Example
See “Synchronizing Your netpad With Microsoft 
Outlook” on page 93 to ensure that this information 
has been entered correctly in the synchronization 
properties.
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11.3.8  Outlook: Failed To Open Custom Form,
Outlook Will Open An Outlook Form Instead

This error message is due to conflicting entries. Find the Outlook entries that have a 
‘crossed swords’ symbol. Double-click this symbol to resolve the conflict.

11.3.9  Lotus Organizer 2.1: Synchronizer Cannot Access 
Required Directory

This is due to the incorrect version of a particular file being loaded 
(the Organizer API). 

To find this file, click the Start button, select Find, then Files or folders. 

On the Named: line, type orgapi.dll and make sure that the Look in: line is set to 
your C drive (or whichever drive the Organizer files were installed to). Then click 
the Find now button. You should get a list of two copies of the file. 

Right-click on each in turn and select Properties. One of the files should have a 
Modified date of 7th November 1995. Right-click again on the file with this date and 
select Delete. Then confirm the deletion and restart the PC.
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11.3.10  Lotus Organizer: Cannot Find xxxx (Section Name)
This error message is due to the section name being incor-
rectly entered in the synchronization properties. Open Orga-
nizer and check the name of the relevant section. Then enter 
the section name in the synchronization properties (see 
“Synchronizing Your netpad With Lotus Organizer” on 
page 110 on how to do this).

11.3.11  Lotus Organizer: Unable To Open xxxx (Section Name)
This is due to a problem in Organizer where, if you rename a 
section, Organizer will sometimes not recognize the change. 
The solution is to rename the section back to its original name 
and change the synchronization properties to reflect this. 

To do this, right-click on the relevant section’s tab. Select 
Rename, type the original name on the New name line and then click the OK 
button. See “Synchronizing Your netpad With Lotus Organizer” on page 110 and 
enter this information in the synchronization properties.
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Psion Teklogix provides a complete range of product support services to its custom-
ers worldwide. These services include technical support and product repairs. 

A.1  Technical Support
Technical Support for netpad is provided via e-mail through the Partner Program 
website. To reach the website, go to www.psionteklogix.com and click on the Partner 
Program link, which takes you to the Partner Program page. Then click on the Log-
in button or the Register button, depending on whether you have previously regis-
tered for Teknet or the Partner Program. (Your UserID and password are the same 
for TekNet and the Partner Program.)

A.2  Product Repairs
International

For product repairs, please contact your local Psion Teklogix office (see 
page A-2). 

Canada/U.S.A
Canadian and U.S. customers can receive access to repair services, by calling 
the toll-free number below, or via our secure website. 

Note: Customers calling the toll-free number should have their Psion Teklogix 
customer number or trouble ticket number available.

Voice: 1 800 387-8898 (press option “2”)

Fax: 1 905 812-6304

Web Site: http://service.psionteklogix.com
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A.3  WORLDWIDE OFFICES

COMPANY HEADQUARTERS 
AND CANADIAN SERVICE CENTRE

Psion Teklogix Inc.
2100 Meadowvale Boulevard
Mississauga
Ontario
Canada L5N 7J9
Tel: +1 905 813 9900
Fax: +1 905 812 6300
E-mail: salescdn@psion.com

INTERNATIONAL SUBSIDIARIES

Psion Teklogix GmbH
Jakob Kaiser Straße 3
D-47877 Willich Münchheide
Deutschland
Tel: +49 2154 9282 0
Fax: +49 2154 9282 59
E-mail: info@teklogix.de

Psion Teklogix S.A.
La Duranne
135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France
Tel: +33 (0) 4.42.908.809
Fax: +33 (0) 4.42.908.888
E-mail: tekeuro@psion.com

Psion Teklogix (UK) Ltd.
Bourne End Business Centre
Cores End Road
Bourne End
Buckinghamshire SL8 5AR, England
Tel: +44 1628 648800
Fax: +44 1628 648810
WWW: www.teklogix.co.uk
E-mail: tekuk@psion.com

Psion Teklogix AB
Stora Badhusgatan 18-20
411 21 Göthenburg, Sweden
Tel: +46 31 13 15 50
Fax: +46 31 13 57 80
E-mail: info@teklogix.se

NORTH AMERICAN HEADQUARTERS 
AND U.S. SERVICE CENTRE

Psion Teklogix Corp.
1810 Airport Exchange Boulevard
Suite 500
Erlanger, Kentucky
USA 41018
Tel: +1 859 371 6006
Fax: +1 859 371 6422
E-mail: salesusa@psion.com

Psion Teklogix Finland
Metsänneidonkuja 8
02130 Espoo
Finland
Tel: +358 9 4307 8390
Fax: +358 9 4307 8395
E-mail: tekeuro@psion.com

Psion Teklogix Danmark
Vesterballevej 4-6
7000 Fredericia
Danmark
Tel: +45 76 24 0133
Fax: +45 75 94 4679
E-mail: tedk@psion.com

Psion Teklogix Italia S.r.I
Via Galilei, 47
20092 Cinisello Balsamo
Milan, Italy
Tel: +39 2 6604 5410
Fax: +39 2 6604 5412
E-mail: tkxitalia@psion.com

Psion Teklogix Inc. (Singapore)
583 Orchard Road
# 15-01 Forum
Singapore 238884
Tel: +65 735 8108
Fax: +65 733 5990
E-mail: intl@psion.com

Psion Teklogix de Mexico, S.A. de C.V.
Sierra Mojada 626, 2º Piso
Col. Lomas Barrilaco, C.P. 11010
Mexico, D.F., Mexico
Tel: +52 55 5 327 1124
Fax: +52 55 5 327 1123
E-mail: salesusa@psion.com

Psion Teklogix do Brasil, Ltda.
Al. Casa Branca, 851 - conj. 101 e 102
São Paulo - SP - 01408-001
Brasil
Tel: +55 11 3064 0868
Fax: +55 11 3068 8198
WWW: www.teklogixbrasil.com.br
E-mail: tekbr@psion.com

Chile Psion Teklogix International Inc.
Avenida Vitacura 2909, Oficina 703
Las Condes
Santiago, Chile
Tel: +56 2 334 9344
Fax: +56 2 233 3868
E-mail: ventas@psion.com

Psion Teklogix de Argentina, S.A.
Avenida Moreau de Justo 1180
Piso 1, Oficina C-105
Buenos Aires 1107
Argentina
Tel: +54 11 4343 0193
Fax: +54 11 4343 6310
E-mail: tekar@psion.com
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Psion Teklogix España, S.L.
Cityparc Ronda de Dalt
Ctra. Hospitalet 147-149
Edificio Atenas 2° 3ª
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Boldface indicates a menu or sub-menu name.

INDEX

A
accessory product list  159
additional programs  8
Afaria  8
AirZip Accelerator  8
alarms

deleting custom sounds  64
recording  63

antenna installation  18
Automatic switch off  60
Axio™  9

B
backup

restoring files  57
to a PC  57
to multimedia cards  57
using PsiWin  91–92

backup battery, caring for  5
bar code scanning  30
battery

enhanced 1400 mAh  160
fitting  20
portable charger  160
safety  xv, xvi
standard 875 mAh  160
4-bay charger  160

Beep on Screen off  61
brightness control  28
Broadbeam Corporation  9
browsing folders  73

C
cables list  161
cancelling a transfer  49
care and safety  5
carrying cases  160
changing

file attributes  75
CIC  9
Citrix ICA  9

city, setting location  55
Click when screen off  61
closing

documents  71
folders  71
programs/files  71

command icons  28
communications settings  44
connecting netpad

to PC  56
to serial modem  140

contrast control  28
Control Panel  58
copying

disks  77
files  76, 77
files, using PsiWin  86–90
folders  76, 77
information between programs  39

creating
files  72
folders  71, 73
Outlook profile  190
wallpaper  62, 63

Current Band  130
customizing

system screen  64

D
data transfer  47
date  55
DB2 Everyplace  10
deleting

alarm sounds  64
files containing wallpaper  63
files on a multimedia card  79

developers CD  161
device conflicts  175
dialling, setting up  141
dialogues

buttons  38
using  37
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dial-up account  135
disks

backup  57
copying  77
renaming  77
viewing files  70

displaying
amount of memory  77
Control Panel  58
help  35, 69, 134

DNS, definition of  137
docking station  41, 43

product packs  159
Universal PSU  159

drop rating  6

E
Eliad Technologies, Inc.  9
e-mail  134

account  136
checklist  139
optional information  140
remote account  135
setting up  123, 140, 146
types of accounts  135
web-based account  136

e-mail, definition of  137
Email program  137
Emissions Information, Canada  xv
entering

information  33
owner information  53

Ericom  10
Ethernet configuration  125
exporting/re-importing

a PC PIM with Organizer  188
a PC PIM with Outlook  183
a PC PIM with Schedule+ 7.x  185

exporting a section  189
Extended Systems  10

F
fax/modem  177
FieldWorker  10
files  33, 67, 74

changing attributes  75
copying  76, 77
memory use  78
moving around  69

naming  72
navigating  32
opening  70, 71
rearranging  73
removing  77
renaming  77
selecting  74
viewing on disk  70

Firmware Rev  130
folders  67, 74

closing  71
copying  76, 77
creating  73
expand display  73
managing  76
moving around  69
naming  72
navigating  32
opening  70
removing  77
renaming  77

frequency band  130

G
glossary of terms  137
GPRS Available  130
GSM/GPRS

antenna  18
modem configuration  129
SIM installation  23

H
hard reset  168
Help  138

search  35
text scroll  35

hostname, definition of  137
humidity  7
HyperTerminal  169

I
IBM  10, 11
icons

command  28
system command  28
troubleshooting  169

IMAP4, definition of  137
IMEI  130
Impatica  11
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Index

Informix Cloudscape  11
Infrared

device safety  xv
printing  152
transfer fails  49
using  45

InkTools™  9
integrated scanner, safety  xv
Intent®  13
International Mobile Subscriber Identity  

130
Internet  134

account  136
setting up  123, 143

IP address, definition of  137
IP rating  6
IRDA  See Infrared
ISP  140
ISP, definition of  137

J
JSmartGrid™  9

K
keyboard

display  28
entering information  33
Psiboard  28
troubleshooting  169

Ki  12

L
Lotus Organizer  See Organizer

M
magnetic fields  7
mailbox

access via a PC  135
accounts  135
connecting through PC  135
connecting to remote by modem  134

memory
card, additional programs  79
displaying  77
file sizes  78
full  78
use, checking  77

menus  28, 36
Microsoft Outlook  See Outlook

Microsoft Schedule+  See Schedule+
MMC  41, 43

accessories  161
MobileIntegrator  12
modem

connecting through serial port  140
setting up  142
troubleshooting  177

moving
between files and folders  73
highlight between files/folders  69
to a program  70

MPS  12
MQSeries Everyplace  11
multimedia cards See MMC

N
naming

files  72
folders  72

netpad
care and safety  5
connecting to PC  56
connecting to serial modem  140
overview  4

O
offices list  A-2
on-screen keyboard  See keyboard
opening

files  70
folders  70

Opera program  137
operating temperature  6
OPL, interference  167
Oracle Corporation  12
Oracle 8i Lite  12
Organizer

exporting/importing PC PIM  188
synchronizing files  110–118
troubleshooting  193, 194

Organizer 97 GS
synchronizing files  118–121

Outlook
exporting/importing PC PIM  183
failed to open  191
failed to open custom form  193
synchronizing files  93–102
troubleshooting  192
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P
page setup  155
Palmware  12
passcode  54
password  See also passcode  54, 75
Pin Required  130
POP3  137
POP3, definition of  137
Portable Battery Charger  160
Power  59
Power saving mode  60
PowerTerm WebConnect  10
previewing a document  155
printing  149

current help card  35
document  156
printer model  154
selecting printer  152
serial printer  153
setting up  151
to a file  153
using Infrared  152
using PsiWin  153

programs  33, 36, 67
additional  79
moving to  70
opening  70, 71
starting  32

programs, additional  8
Psiboard  See keyboard
PsiWin

about  83
backing up  91–92
connection problems  172
copying files  86–90
installing  172
opening files  90–91
synchronizing files  92
synchronizing files with Organizer  

110–118
synchronizing files with Organizer 97 

GS  118–121
synchronizing files with Outlook  

93–102
synchronizing files with Schedule+  

103–110
troubleshooting  180
using  56
using to print  153

R
radio card parameters  130
radio parameters  129
Radio Status  129
rearranging files  73
recording alarms  63
removing

files  77
folders  77

renaming
disks  77
files  77
folders  77

resetting netpad
hard  168
soft  29, 167

restoring files from backup  57

S
safety

battery  xv, xvi
Infrared  xv
instructions  xiv
integrated scanner  xv
summary  ix

scanner use  30
Schedule+

synchronizing files  103–110
7.x, exporting/importing PC PIM  185

screen, caring for  5
screen, overview  28
Screen tap switch on  59
search help  35
securing your information  62
Serial Number  130
serial printer  153
Series 3/3a/3c/3mx/5/5mx program  79
setting

system passcode  54
time, date, home city  55

setting up
dialling  141
e-mail  123, 140, 146
Internet  123, 143
modem  142
printer  151

Signal Quality  129
signal strength indicator, 802.11  128
SIM, installation  23
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Index

SIM IMSI  130
SMTP, definition of  137
soft reset  29, 167
sorting lists  74
SQL Anywhere Studio  12
static electricity  7
storage temperature  7
stylus

replacement  161
using  27

Subscriber Identity Module See SIM
switching on  18
Switch off after  60, 61
Sybase  12
synchronizing files  92

Organizer  110–118
Organizer 97 GS  118–121
Outlook  93–102
Schedule+  103–110

system
command icon  28
passcode  54

SystemsGO!™  9

T
Tao  13
TCP/IP, definition of  137
temp folder  178
text conventions  4
third party applications  8
time  55
toolbar  28
touch screen calibration  31
transferring information  48
Transmit rate  127
troubleshooting  163

alarm  165
command icons  169
docking station  168
fax/modem  177
file vanished  166
general tips  165
keyboard  169
Lotus Organizer  193, 194
netpad basics  173
netpad on/off  166
Outlook  191, 192, 193
passcode (password)  166
PC basics  174

PsiWin  172, 180
synchronization problems  180
temp folder  178
using HyperTerminal  169
world times  165

turning on/off  26

U
Universal PSU  159

W
wallpaper

creating  63
selecting  63

website address  A-3
worldwide offices  A-2

X
XcelleNet  8
XML-Run™  9
XTNDConnect Server  10

Z
zoom control  28

4-Bay Battery Charger  160
802.11

antenna  18
radio configuration  125
Signal Strength Indicator  132
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